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Introduction

Document history

Version Remarks
V2.0.0 28.08.2007 New Manual - RELEASE status
V2.1.0 11.04.2008 Added Marlin camera in Chapter Sequence mode (Stingray, Pike,

Marlin) on page 131

Corrected screenshot in Figure 20: Properties dialog of
SmartView on page 107 (...AVT_SmartView_1_7.exe” -i)

Added Chapter FireWire hot-plug and screw-lock precautions on
page 15

Revised Chapter Licensing on page 19

Revised Chapter LUT/Shdg. tab descriptions on page 49
Revised Chapter Working with LUTs on page 84

Added Chapter Using LUT editor with built-in viewer: Overview
on page 90

Changed screenshots from SmartView 1.7 to 1.8 in Chapter AVT
SmartView for FirePackage on page 15ff. and in Chapter Oper-
ating AVT cameras with SmartView on page 63ff.

New zoom out function and new button original image size on
page 28. New zoom functions (zoom in/out/min/max) on page
33.

V2.2.0 16.10.08 New LUT editor and operation of LUT editor changed: see Chap-
ter Working with LUTs on page 84ff.

to be continued on next page
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Version Date Remarks

continued from last page
V2.3.0 14.01.11 Minor corrections

Switch off PC or laptop before connecting camera:

e see Chapter Turn off PC or laptop on page 17

e see Chapter Connecting camera to PC or laptop on page
17

e see Chapter Connecting camera to PC or laptop on page
17

New features from Stingray update round:

e Disable LEDs: see Table 17: SmartView Edit settings: Adv 3
tab on page 56

e Software trigger: see Software trigger on page 48

New features for Pike cameras having KODAK sensors with

two channels (Pike F-032/Pike F-210/Pike F-421/

Pike F-505)

e Dual-tap offset adjustment:
- see Adjust channels... Alt+Ctrl+A on page 35

Deleted Dolphin (discontinuation) and added Stingray
cameras:

¢ Added Stingray and Marlin cameras in description of
Sequence dialog... on page 35

¢ Added Stingray, deleted Dolphin in Chapter Overview:
Edit settings window on page 37

¢ Added Stingray cameras in description of High SNR mode
on page 38

¢ Added Stingray, deleted Dolphin in Sharpness on page 42

¢ Added Stingray, deleted Dolphin in Deferred transport on
page 52

® Deleted Dolphin (Local color anti-aliasing) in section
Color on page 54

¢ Deleted Dolphin in Table 21: Description of debayering
algorithms on page 64

e Deleted Dolphin in Table 27: Recommended number of
images for shading data on page 81

to be continued on next page
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Introduction
Version Date Remarks
continued from last page
V2.3.0 14.01.11 Added Guppy F-503:
[continued] [continued] ¢ Added Guppy F-503 Defect Pixel Correction: see Defect

Added Guppy PRO cameras:

Added deep images for Stingray/Guppy PRO cameras,
revised availability for Guppy cameras (only Guppy F-146
and F-503):

Pixel Correction (only Guppy F-503 and Guppy PRO F-503)
on page 60

Added Guppy F-503 Electronic Rolling Shutter and Global
reset release shutter:

see Shutter mode (only Guppy F-503) on page 61

Added Guppy PRO in Table 32: Description of LUTs
depending on camera type on page 87

Added Guppy PRO and Stingray cameras in description of
Submenu Update firmware... on page 22

Added Guppy PRO and Stingray cameras in description of
Format 7 mapping... on page 22

Added Guppy PRO and Stingray and in Color correction
on page 56

Added Guppy PRO, deleted Dolphin in Table 30: Number
of LUTs depending on camera type on page 85

Added Guppy PRO, deleted Dolphin in Table 31: Gamma
LUT: incoming/outgoing bits on page 85

Added Guppy PRO, deleted Dolphin in Table 32:
Description of LUTs depending on camera type on page 87
Added Guppy PRO in Chapter Packed 12-Bit Modes (only
Stingray/Pike/Guppy PRO) on page 130

Added Software features and descriptions for Guppy PRO
and Stingray cameras (Disable LED) and Number of
digitization taps for cameras with multi-tap sensors: see
Software features on page 56.

Added Guppy F-503, Guppy PRO F-503 in Chapter CMOS
tab descriptions on page 58

See Table 25: Which cameras can use deep images? on
page 72

to be continued on next page
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Introduction
Version Date Remarks
continued from last page
V2.3.0 14.01.11 Revised all chapters to fit with SmartView 1.12
[continued] [continued] New file format:

e (Converted file format from FM7 to FM9
Changed naming conventions:

® FirePackage means now: 32-bit and 64-bit versions. The
name FirePackage64 is not used any more due to develop-
ers reasons.

Added Windows 7 support (deleted Windows NT and Win-
dows 2000):

e See Chapter Supported operating systems on page 16 and
Chapter Installing IEEE 1394 adapter on page 16

Added/revised items due to SmartView update rounds:

® New screenshot of SmartView entry window (the serial
number is listed now instead of the vendor for AVT
cameras. Example: Instead of Pike FO32C(AVT) now
Pike F032C(#26789123) is listed.) See Figure 1:
SmartView entry window: example of Pike F-145B fiber on
page 20

e Save and Record functions are now also available during
acquiring images: see Table 6: Functions of SmartView
available via icon bar on page 26ff.

e New function Low noise binning on Format tab. New
screenshot: see Figure 2: SmartView: example of Edit
Settings dialog (Pike F-505B) on page 29

e The following entry has vanished from Menu: View -
Additional information: Secure Image Stamp Info and
moved to Extras = Show SIS data. See Table 7: Functions
of SmartView available via menu on page 31ff.

e Set minimum zoom was deleted and replaced with Set
neutral zoom (incl. icon). See Table 7: Functions of
SmartView available via menu on page 31ff.

® View Secure Image Stamp info renamed to Show SIS data
in Menu Extras: See Table 7: Functions of SmartView
available via menu on page 31ff.

e Inserted Low noise binning in Format tab: see © Low
noise binning on page 39

e Inserted Software trigger modes (-SW) in Table 13:
SmartView Edit settings: Trig/I0 tab on page 46

to be continued on next page
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Introduction
Version Date Remarks
continued from last page
V2.3.0 14.01.11 Added/revised items due to SmartView update rounds
[continued] [continued] [continued ...]:

e In Trig/I0 tab descriptions added Period/Width/
Debounce column (all 3: PWM features): see Period
column on page 48; see Width column on page 48; see
Debounce column on page 48.

* Deep images can be used also with MONO12/RAW12
modes and Packed 12-Bit Mode is available with
Stingray/Guppy/Guppy PRO models: see Chapter Using
deep images (only MONO12/16 mode or RAW12/16 color
mode) on page 71

e Reorganized the following table: see Table 25: Which
cameras can use deep images? on page 72

¢ Added Stingray and deleted Dolphin in Chapter Working
with shading on page 77ff.: see Chapter Additional
information on page 78 and Chapter Conditions on page
78

Added/revised items due to SmartView update rounds
[continued ...]:

e Added Advé4 tab: see Chapter Adv 4 tab descriptions (only
Stingray) on page 57

e Added RAWS8 condition for hue and saturation: see Only
RAW8 formats: additional adjustment of hue and
saturation possible (using methods YUV422/LCAA/
LCAA+V): on page 63

e Additional adjustment of hue and saturation does not
depend on specific camera family but on RAWS8 format,
see Chapter Additional adjustment of hue and saturation
on page 65

¢ Added new namings of Edge mode, Level mode, Progr.
mode (incl. -Ext for external trigger; -SW for software
trigger) in Table 36: Description of trigger modes on page
102

¢ Added log level ,-d” for debug in Chapter Using logging
functionality of SmartView (*.cmd file) on page 106

® New screenshot for AFE channel adjustment (not only
gain adjustment but also offset adjustment): see Figure
22: Channel balance: Example (Pike F-032C) on page 108

® Revised description of channel balance (not only gain
adjustment but also offset adjustment): see Chapter Pike
channel balance on page 108ff.

to be continued on next page

Table 1: Document history
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Version Date Remarks
continued from last page

V2.3.1 27.06.11 Defect pixel correction for Pike F-1100/1600
and Guppy F-503 / Guppy PRO F-503:

¢ Added Note Defect pixel correction with cross reference
to Pike Technical Manual in Chapter Adv 4 tab
descriptions (Defect pixel correction: only Pike) on page
57.

¢ Added description Defect Pixel Correction (only Guppy F-
503 and Guppy PRO F-503) on page 60

Marked features (incl. index) that are not camera features,
which means they are only available inside SmartView:

e Auto Chn. see ISO channel on page 39

® Frame buffers on page 39

e Debayering on page 38

e Extra features during debayering on page 44

® Hue on page 44

e Saturation on page 44

e HDR: Easy mode on page 59

e Chapter Working with the histogram function (SmartView
feature only) on page 75

Smaller corrections:

e (Corrected: GRBG instead of GRGB in Table 22: Description
of BAYER patterns on page 65

e Revised Chapter Using deep images (only MONO12/16
mode or RAW12/16 color mode) on page 71

to be continued on next page

Table 1: Document history
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Conventions used in this manual

To give this manual an easily understood layout and to emphasize important
information, the following typographical styles and symbols are used:

Styles
Style Function Example
Bold Programs, inputs or highlighting |bold
important things
Courier Code listings etc. Input
Upper case Register REGISTER
Ttalics Modes, fields Mode
Parentheses and/or blue Links (Link)
Table 2: Styles
Symbols
Note This symbol highlights important information.
Caution This symbol highlights important instructions. You have to
/ follow these instructions to avoid malfunctions.
www This symbol highlights URLs for further information. The URL

itself is shown in blue.

Example:

http://www.alliedvisiontec.com

AVT SmartView for FirePackage V2.3.1
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Introduction

Before operation

The FirePackage SmartView Manual is the guide to the installation of the
software and the operation of AVT cameras with SmartView.

Note Please read through this manual carefully before operating

AVT cameras with SmartView.

AVT SmartView for FirePackage V2.3.1
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AVT SmartView for FirePackage

In this manual FirePackage means both: 32-bit version as well as 64-bit
version.

Hardware conditions

e PC or laptop with built-in IEEE 1394 interface

e TEEE 1394 adapter (OHCI) card for PCI bus or PCI Express bus or PC card
or ExpressCard with IEEE 1394 port(s)

Note AVT offers a wide range of IEEE 1394 adapters, both 1394a or

1394b for different requirements.

FireWire hot-plug and screw-lock precautions

Caution Hot-plug precautions
e Although FireWire devices can theoretically be hot-
plugged without powering down equipment, we
strongly recommend turning the computer power off,

before connecting a digital camera to it via a FireWire
cable.

e Static electricity or slight plug misalignment during
insertion may short-circuit and damage components.

e The physical ports may be damaged by excessive ESD
(electrostatic discharge), when connected under pow-
ered conditions. It is good practice to ensure proper
grounding of computer case and camera case to the
same ground potential, before plugging the camera
cable into the port of the computer. This ensures that
no excessive difference of electrical potential exists
between computer and camera.

Screw-lock precautions

e Also, all AVT 1394b camera and cables have industrial
screw-lock fasteners, to insure a tight electrical con-
nection that is resistant to vibration and gravity.

* We strongly recommend using only 1394b adapter
cards with screw-locks.

AVT SmartView for FirePackage V2.3.1
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Supported operating systems

... for FirePackage:

e  Windows XP (32 bit and 64 bit)

® Windows Vista (32 bit and 64 bit)
e  Windows 7 (32 bit and 64 bit)

Note The AVT FirePackage includes a special IEEE 1394 device
driver from INTEK suitable for all AVT cameras which replaces

@ the MS 1394 driver stack completely.

Overview FirePackage

e Install IEEE 1394 adapter (if PC or laptop does not have an IEEE 1394
port)

e Install FirePackage (incl. SmartView)

e Start SmartView

e Connect camera to PC or laptop and ensure that the camera is powered

e License will automatically be read out from your AVT camera (in case of
problems, contact AVT support)

e Get your first image with SmartView
® Problems? Read Chapter Troubleshooting on page 25.

Installing IEEE 1394 adapter

Note When you install FirePackage the SmartView program will

automatically be installed.

1. PC: Install the IEEE 1394 adapter according to the instructions you got
from your adapter manufacturer.
Laptop: Insert the IEEE 1394 PC Card into your laptop. Connect external
power supply to the adapter to power the camera or power the camera
via Hirose connector.

Windows XP/ Windows Vista/Windows 7 will detect the hardware auto-
matically and installs a Windows 1394 driver.

AVT SmartView for FirePackage V2.3.1
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Installing FirePackage (incl. SmartView program)

9.

Download AVT FirePackage from the AVT website.
To start the installation of FirePackage unzip AVT FirePackage x.y.zip
Double-click on AVTFirePackage_3_0.exe.

A wizard will guide you through the installation. To go on click Next in
each window.

You are asked to choose a directory: Accept the option shown or type
another one. Click Next.

Activate all 3 check boxes. Click Next to start installation.
AVT FirePackage is being installed.
The INTEK window appears.

Now install the driver for the IEEE 1394 adapter: for each card to be
used with FirePackage, activate the check box.

Click Install.

Ignore the message box (Microsoft non-certified driver) and continue
the installation.

A wizard will guide you through the installation. To continue click Next
in each window.

A window appears: FirePackage has been successfully installed.
Click Close.

Now the FirePackage and the SmartView Program are installed on your PC
or laptop.

Turn off PC or laptop

1.
2.
3.

Close all programs.
Shutdown Windows.
Turn off PC or laptop.

Connecting camera to PC or laptop

Insert one end of the FireWire cable into your 1394 adapter or 1394 PC
card.

Insert the other end of the FireWire cable into your camera.

Check that the camera is powered (green LED ON)

AVT SmartView for FirePackage V2.3.1
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Switch on PC or laptop

1. Switch on PC or laptop.
2. Wait until Windows has started.

Starting SmartView

The SmartView program:
e enables access to all connected IEEE 1394 cameras
e supports almost all smart features of the AVT cameras.

1. Click Start > Programs -> Allied Vision Technologies > FirePackage
= AVT_SmartView

The SmartView window opens.

2. Here you can see all 1394 buses and PCI slots (e.g. 0x040800).

AVT SmartView for FirePackage V2.3.1
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AVT SmartView for FirePackage

Licensing

You need a license to run the FirePackage. This license is embedded in each
AVT camera. It will be read out with the help of the license file LICENSE.TXT.

Note Newer versions of AVT FirePackage
(> 2V6) use additional registry keys for supplying alternative
@ names and positions for the license file to be stored.
Note For detailed licensing infos read:
@ e AVT FirePackage User Guide, Chapter Licensing

AVT SmartView for FirePackage V2.3.1
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First steps with SmartView

1. After connecting the camera with your PC or laptop, start SmartView
program. In the SmartView entry window you see all FireWire adapters
or cards installed in your PC.

2. In the SmartView entry window open all trees by clicking on the [+]
button. Search for your camera and double-click on the camera entry.

5. AVT SmartView 1.12

Camera Wiew Help

B 7

= OHCILynx [0x050200)
g . Stingray F145BF [#28577.3954]

Ready

Figure 1: SmartView entry window: example of Pike F-145B fiber

3. The SmartView main window opens and usually one first image is shot
automatically.

AVT SmartView for FirePackage V2.3.1
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Overview: SmartView entry window

The menus and icons of the SmartView entry window are explained in the fol-
lowing tables:

Icon Function Description
General settings | Opens the General settings window

(see Table 5: SmartView entry window:
General settings on page 23)

Here you can adjust settings for
connecting 1394 cards to the 1394
bus, image type settings and camera
view settings.

? Information Shows version and copyright
information of AVT SmartView for
FirePackage

Table 3: SmartView entry window: toolbar

AVT SmartView for FirePackage V2.3.1
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Menu

Camera

Submenu

Open/Close view

Shortcut
Ctrl+0, Enter

/1

Description

Opens or closes a viewer window (main window)

Initialize the camera

Initializes the selected camera

Soft reset

Resets the selected camera

Update firmware...

Updates the firmware of the Guppy/Guppy PRO/
Pike/Stingray camera via 1394 bus

Read the application note: How to update
Guppy/Guppy PRO/Pike/Stingray firmware at
AVT website (Support - Knowledge Base; search
for firmware update).

For other cameras: Read the chapter Firmware
update of the Technical Manual or contact your
local dealer.

Format 7 mapping...

Only Pike/Stingray/Guppy PRO: Allows mapping
of all possible Format_7 settings to F7M1..F7M7
(see Pike/Stingray/Guppy PRO Technical
Manual, Chapter Binning and sub-sampling
access)

Settings...

Alt+E

Opens the General settings window (see Table 5:
SmartView entry window: General settings on
page 23)

Here you can adjust settings for connecting 1394
cards to the 1394 bus, image type settings and
camera view settings.

Exit

Alt+X

Quits the application

View

Toolbar

Shows or hides the toolbar (see Table 3:
SmartView entry window: toolbar on page 21)

Status bar

Shows or hides the status bar

Help

About AVT SmartView...

Shows version and copyright information of AVT
SmartView for FirePackage

Table 4: SmartView entry window: menus

In SmartView entry window click on Camera > Settings.

The General settings window opens.

AVT SmartView for FirePackage V2.3.1
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Section

Check box / combo box/ list

/1

Description

Enable initial card states

O Enable initial card states

This function is useful, if you have
more than one card installed and
several cameras.

Activate this check box and disable
cards you don’t use and set your
working card to False, so that
connected cameras are shown
automatically.

Card ID list

Lists all 1394 cards (connected to
your PC/Laptop) with their ID
number.

To disable a card, set the Disabled
parameter to True.

To open the bus when SmartView is
started, set the AutoOpen parameter
to True. All connected 1394 cameras
of this card will be searched and
opened automatically.

Camera

O Automatically open camera views
on startup

Activate this check box to view all
connected cameras automatically,
when corresponding card is opened.

[0 Selected cameras only

Activate this check box to show only
selected cameras from the list, when
SmartView is started.

The list shows all cameras, that have
been connected to your PC/laptop
and have been opened with
SmartView.

Select one or more cameras by
clicking on the camera name.

Image file type

Default type used by
'Save’ & ‘Save as’

W

Choose your standard image file type
for the Save and Save as operation.
The following types are available:

bmp, jpg, gif, tif, png

L] Override extension entered by the
user

If you activate this check box, all
settings made within the Save and
Save as command are ignored.

Table 5: SmartView entry window: General settings

AVT SmartView for FirePackage V2.3.1
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Section

Check box / combo box/ list

/1

Description

Camera view settings

L] Always scale image to view size

Standard setting for each window.
Activating this check box will scale
the camera image to the SmartView
viewer window size. Otherwise the
camera image size is not scaled to the
viewer window size.

O Resize camera view on resolution
changes

Standard setting for each window.
Activate this check box to adapt the
viewer window to each resolution
change of the image size (fixed
modes) or the AOI size (Format 7
settings).

Table 5: SmartView entry window: General settings

AVT SmartView for FirePackage V2.3.1
24




///ALLIED

Vision Technologies

AVT SmartView for FirePackage
|

Troubleshooting

If the image is completely black, completely white or the image quality is
poor, then try the following steps:

e If not done yet, remove the lens cap.

e If the image is black, open the aperture. If the image is white, close the
aperture.

e If the image quality is poor, try changing the focus.

If you still don't get any image at all, then try the following steps:
e Check the FireWire plug of your camera and PC/laptop.

e C(Check the LEDs on the back of the camera.

AVT SmartView for FirePackage V2.3.1
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Icon bar of SmartView (main window)

The following table shows all functions of SmartView (main window) avail-
able via the icon bar.

Icon Function Description
=) Save Saves the image(s) to the file you
have previously set with Save as...
command. Also possible during
acquiring images (takes more time).
Edit Settings Opens a settings window

Here you can adjust the settings for
the standard registers, e.g. exposure
time or gain (IIDC specification) and
the settings for advanced AVT
features.

The following tabs are available:

e Format

e (trl1

o (trl2

e (trl 3 (only for certain color
cameras)

e Trig/IO

e LUT/Shdg.

e Adv1

e Adv?2

e Adv 3 (not all cameras)

e Adv 4 (only Stingray)

e (CMOS (only for cameras with
CMOS sensor)

Some settings can only be changed
when the camera is in idle mode.

Table 6: Functions of SmartView available via icon bar

AVT SmartView for FirePackage V2.3.1
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Icon

)

Function

Direct register
access

/1

Description

Opens a window (Direct Access dialog
box)

For an example see Figure 3:
SmartView: example of DirectAccess
dialog (Marlin F-080C-30fps) on page
30.

Enables you to access all features by
their address and to change the
register of the AVT camera directly.
All settings can be changed while the
camera is running, although some
features will only take effect after you
stop and restart the camera.

Start iso

Acquires images continuously

Multi-shot

Acquires multi images as set in the
Edit Settings > TriggerI/0 tab >
Multishot counter combo box

One-shot

Acquires only one image

Stop

Stops acquiring images (free-run or
multi-shot)

Record

Records images to individual file
names you have set under File >
Recording options...

This function can also be used during
image acquisition.

Display image
coordinates

Displays the image coordinates in a
yellow bubble box on top of mouse
cursor

X

Table 6: Functions of SmartView available via icon bar

AVT SmartView for FirePackage V2.3.1
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Icon

Function

Display image
coordinates and
image values

/1

Description

Displays the image coordinates and
the image values (intensity) in a
yellow bubble box on top of mouse
cursor

(276/115)
159186 114

X

L3

color image b/w image

1203

Display format
options in status
bar

Displays the format options in the
status bar.
Example: 2080x1540x8 (RAW8)

Increase zoom
factor

Increases the image zoom factor in
0.1x steps (0.1x, 0.2x, ..., 0.9x) and
1.0x steps (1.0x, 2.0x, ..., 32.0x)

Show original
image size

Displays the image in original image
size (zoom=1.0x)

Decrease zoom
factor

Decreases the image zoom factor in
1.0x steps

(32.0x, 31.0x, ..., 2.0x, 1.0x)

and in 0.1x steps

(0.9x, 0.8x, ..., 0.1x)

Quick read
settings from file

Reads settings from file to which you
have written your settings.

Quick write
settings to file

Writes settings to the file you have
chosen.

| 8%

About

Shows version number, copyright
information and link to Allied Vision
Technologies:
http://www.alliedvisiontec.com/

Table 6: Functions of SmartView available via icon bar

AVT SmartView for FirePackage V2.3.1
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Pike F505B [C 0, N 0] - AVT SmartView 1.12 3
Format |Ctrl 1 | Ctrl 2 | Trig/10 | LUT/Shdg. | Adv 1 | Adv 2 | adv 3|

Fixed & variable modes. ..
Format Color Framerate IS0 speed Debayering
690480 ||| (LELaleEE —invalid — | [5100 none
800x600 | |Monolb 5200
1024768 Mono12 auto. pattern
1280x960 5800
1600x 1200 De-Interlace
F7mode 0 = '
= ——— High SMR. mode
E; mnge é 150 channel  [°ff b
mode
F7mode 84— ] Low Auto chn.  Frame buffers
noise
F7mode 5 v | binning |':' v| | 3 v |
Format? settings... (max. 1224 x 10248)
Left (£ 2 px) Width (£ 4 px) Top (£ 2 px) Height (£ 2 px)
o = R
20 Packet size 3460 Auto size Max frame rate
| 3480 | |z201fps |
Don't auto hide IEI EI IEI IEI

Figure 2: SmartView: example of Edit Settings dialog (Pike F-505B)

AVT SmartView for FirePackage V2.3.1
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Matrlin FO80C-30fps (CO, ND} - Direct ac...[¥]

Register: | 150 EMAELE v|
Address: |F|:|F|:u:|514 v| [ Read |
Data: | O00ooooo | [ write |
#| rw Address Value
rd  FOFOD614 00000000
1 wr  FOFOFO4C 00000000
i | 11T ]l|

Figure 3: SmartView: example of DirectAccess dialog (Marlin F-080C-30fps)

AVT SmartView for FirePackage V2.3.1
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Menu structure of SmartView (main window)

Menu

File

Submenu

B Save  Ctrl+S

Description

Saves the image(s) to the file you have previously set
with Save as... command.

Save as... F12

Click here to save an image to hard disk or network
drive. Choose file format (BMP, JPEG, GIF, TIFF, PNG)
and directory. After that you can save an image to

this file by clicking on Save.

Recording options...

Click here to configure the recording options. After
that your are able to save images in streaming
format, that means one file with a successive
numbering per image.

See Chapter Streaming images: recording options on
page 70.

Use deep images

Ctrl+Shift+P

Allows to use images with more than 8 bit
(depending on camera model).

See Chapter Using deep images (only MONO12/16
mode or RAW12/16 color mode) on page 71.

Exit

Alt+X

Click here to exit main window of SmartView.

Table 7: Functions of SmartView available via menu

AVT SmartView for FirePackage V2.3.1
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Menu
Camera
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Submenu Description

B Free-run Alt+R Acquire continuous images.

B, Multi-shot Alt+M Acquire n images.

Bl One-shot Alt+G Acquire one image.

H Stop Esc Stop the free-run or multi-shot modus.

& Record Ctrl+R Record individual images according to the settings

you have made in File > Recording options...
See Chapter Saving and streaming images on page
68.

Settings > Settings dialog Alt+E

Opens the Settings dialog.

® For short overview see Chapter Edit settings
window (for specialists) on page 37.

e For deep description on complex, difficult to
understand settings see Chapter Operating AVT
cameras with SmartView on page 63.

Settings > &4 Quick Read settings
Ctrl+Shift+R

Reads settings from file to which you have written
your settings.

Settings > #§ Quick Write settings
Ctrl+Shift+W

Writes settings to the file you have chosen.

Settings = Select Settings file...

Choose a file where your settings will be stored.

Settings = Read Settings from external file...

Choose an external file from which the stored
settings will be read.

Settings = Write Settings to external file...

Choose an external file to which your settings will be
stored.

Settings 2> Search for camera by GUID

Searches by camera ID; Default: activated

@ Direct access dialog Alt+D

Opens a window (Direct Access dialog box)

Enables you to access all features by their address
and to change the register of the AVT camera
directly.

All settings can be changed while the camera is
running, although some features will only take effect
after you stop and restart the camera.

Options > Automatically load settings
on camera open

Activate check box to load settings automatically
when the camera is opened.

Options > Automatically save settings
on camera close

Activate check box to save settings automatically
when camera is closed.

Options 2> Start Free-Run automatically
on camera open

Activate check box to start free-run automatically
when the camera is opened.

Options 2> Start One-Shot on camera
open

Activate check box to start one-shot when the
camera is opened.

Options > Set shutter, gain and white
balance automatically

Activate check box to set shutter, gain and white
balance automatically.

Options > Start with display maximized
on camera open

Activate check box to start with the SmartView
display maximized when the camera is opened.

AVT SmartView for FirePackage V2.3.1
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Menu
View
(cont. on
next
page)

Submenu

Toolbar

/1

Description
Activate check box to display the toolbar.

Status bar

Activate check box to display the status bar.

Set display size to »

Current AOI Alt+9
Current image size Alt+8
Ratio-corrected image size Ctrl+Shift+A
160x120 Alt+1
320x240 Alt+2
640x480 Alt+3
800x600 Alt+4
1024x768 Alt+5
1280x960 Alt+6
1600x1200 Alt+7
User size... Alt+0

The listed formats set the display size of the window
and are independent from camera types. If the
display of your monitor is smaller than the chosen
display size, then the display format is resized
automatically to fit to your monitor.

Additional information »

The following information is available:

Coordinates
Coordinates/Pixel values
Image info  Ctrl+Shift+I
Histogram Ctrl+Shift+H

= The histogram function is a SmartView feature, but
not a camera feature.

Disable display of image

Activate check box to disable the display of an
image.

@, Zoom in Alt+"+" Click here for zooming in an image.
Each click increases the image zoom factor in 0.1x
steps (0.1x, 0.2x, ..., 0.9x) and 1.0x steps (1.0x,
2.0, ..., 32.0x)

E Zoom out Alt+"-" Click here for zooming out an image.

Each click decreases the image zoom factor in 1.0x
steps

(32.0x, 31.0x, ..., 2.0x, 1.0x)

and in 0.1x steps

(0.9%, 0.8x, ..., 0.1x)

&), Set neutral zoom  Alt+Ctrl+"="

Click here for setting neutral zoom
(zoom factor 1.0).

Set maximum zoom Alt+Ctrl+"+"

Click here for setting maximum zoom.

Table 7: Functions of SmartView available via menu
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Menu
View
(cont.
from last
page)

Submenu

Resize view on format change

/1

Description

Standard setting for each window.

Activate this check box to adapt the viewer window
to each resolution change of the image size (fixed
modes) or the AOI size (Format 7 settings).

Always scale image to window
Alt+S

Standard setting for each window. Activating this
check box will scale the camera image to the
SmartView viewer window size. Otherwise the camera
image size is not scaled to the viewer window size.

Reset position of settings dialog

Click here to reset the position of the settings dialog.
Use this if you cannot see the settings windows after
starting SmartView.

Table 7: Functions of SmartView available via menu
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Menu
Extras

Submenu

Set async speed

/1

Description

The following values are available: $100, S200, S400,
S800 (only 1394b cameras).

Use manual settings if you want to limit async.
communication with camera to lower speed. Helpful
in the case of longer cables (e.g. 20 m at S200) or
needed for communication over up to 100 m using
network cable at $S100.

AUTO (activate check box for auto-detection of
max. async speed)

Allow async block transfer

Disabling async. block transfer may be helpful for the
communication with third party cameras.

Drop faulty frames

Activate check box for dropping defective frames. A
frame is called defective, if during transmission of
the frame an error occurred.

Auto-flush logging file

Activate check box for logging messages immediately
into logging file. If check box not activated,
messages will only be logged when buffer full. For
more information see Chapter Using logging
functionality of SmartView (*.cmd file) on page 106.
Default: not activated

Adjust channels... Alt+Ctrl+A

Only Pike cameras: see Pike Technical Manual,
Chapter: Channel balance

Only the following Pike cameras having KODAK
sensors with two channels (Pike F-032/Pike F-210/
Pike F-421/Pike F-505): see Pike Technical Manual,
Chapter: Channel balance, Subsection: Dual-tap
offset adjustment with SmartView (1.10 or
greater)

Show SIS data...

Only Marlin, Pike, Stingray cameras: see Chapter
Secure image signature (SIS) (Marlin, Pike, Stingray)
on page 134

Sequence dialog...

Only Stingray, Pike, Marlin cameras: see Chapter
Sequence mode (Stingray, Pike, Marlin) on page 131

Table 7: Functions of SmartView available via menu
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Menu
Help

Submenu

@ About AVT SmartView...

/1

Description

Shows version number, copyright information and
link to Allied Vision Technologies:
http://www.alliedvisiontec.com/

Tooltip help for settings

Activate Tooltip help for settings to get help when
moving mouse cursor over window elements
(buttons, lists, check boxes etc. of main window and
Edit settings window). You will get tooltips in form
of bubble help.

Example:
Marlin F131B - A¥T [Card 0, Node l]] - A¥T Smart¥iew 1.
Format |yl * ady 1 [ Adv 2 |
) The avallal:ule,l'selected

Fixed &4  fived resolutions and
Format | foemat 7 modes for this  prate 150 speed
640x430 camera fps
B00:E0 - fps
1024x768 SF 5
F7 mode 0

Table 7: Functions of SmartView available via menu

AVT SmartView for FirePackage V2.3.1
36



http://www.alliedvisiontec.com

AVT SmartView for FirePackage / / /

Edit settings window (for specialists)

Where to find

SmartView (main window): Edit settings

Overview: Edit settings window

Note Display of tabs depends on camera types.
If a camera does not have tab-specific features implemented,
@ the corresponding tab will not be displayed.

Depending on camera type the following tabs may be displayed:
* Format tab

e Ctrl1tab

e (Ctrl2tab

e (Ctrl 3 tab
(only Pike/Stingray color cameras and Guppy interlaced color cameras)

e Trig/IO0 tab

e LUT/Shdg. tab

e Adv1tab

e Adv2tab

e Adv3tab

e Adv4tab

e (CMOS tab (only CMOS cameras)

AVT SmartView for FirePackage V2.3.1
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Format tab descriptions

Section Check box/combo box/list/slider Description

Lists the fixed resolutions and Format_7
modes of the camera model.
Depending on the camera model the
following formats may be available:
® Fixed formats

- 320x240

- 640x480

- 800x600

- 1024x768
e Format_7 modes

- F7 mode 0

- F7 mode 1

Lists the available color modes of the
selected fixed format / Format_7 mode.
Depending on the camera model and the
selected resolution / F7 mode the
following color modes may be available:
Mono8, YUV411, YUV422, RGBS, RAWS,
RAW16, RAW12...

Lists available frame rates in fixed
modes.
List is invalid for Format_7 modes.

Lists available ISO speeds.

1394a: S100, S200, S400

1394b: additional S800

The camera will use this speed for the
video data transmission, async.
communication may use another speed.
See Submenue Set async speed on page
35.

See Chapter Debayering algorithms on
page 63.
= Debayering is a SmartView feature,
but not a camera feature.

Fixed & variable Format

modes...

[to be continued on

next page]
Color
Framerate
IS0 speed
Debayering
High SNR mode

Choose number of images for High SNR
mode. This is an image averaging
function.

See Pike/Stingray Technical Manual,
Chapter High SNR mode (High Signal
Noise Ratio)

Table 8: SmartView Edit settings: Format tab
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Section

/1

Check box/combo box/list/slider Description

Fixed & variable
modes...
[continued]

ISO channel

W

Set no. of ISO channels. (This is a 4-bit

address to identify the source of a video

data stream). Normally set to Auto Chn.

Otherwise all cameras connected to one

bus must have a different ISO channel.

= Auto Chn. is a SmartView feature,
but not a camera feature.

Frame buffers

Y
w

By default SmartView reserves 16 frame
buffers per camera in main memory.
You can change that to a max. limit, which
is dependent on your system and 0S. After
changing, SmartView displays how many
buffers it currently uses (e.g. 2/786) so as
not having to drop any frames coming
from the camera.
The minimum of 3 ensures that normally
no image from camera is to be discarded
because of no available memory.
= Frame buffers is a SmartView
feature, but not a camera feature,
and is automatically saved in the
registry (but not in the user sets)
when closing SmartView.

O Low noise binning

Only Pike/Stingray:

Enables/disables low noise binning mode.
This means: an average (and not a sum) of
the luminance values is calculated

within the FPGA.

The image is therefore darker than with
the usual binning mode, but the signal
to noise ratio is better (approximately a
factor of 2).

Table 8: SmartView Edit settings: Format tab
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Section

/1

Check box/combo box/list/slider Description

Format7 settings...
(max. abcd x efgh)

Left/Width/Top/Height

Y
w

These are the AOI settings (only available
in Format_7 modes)

For more information see Chapter Setting
AOI (Format_7 settings) on page 120.
Adjust width and height of camera image.
For images smaller than maximum image
dimensions: adjust upper left corner via
left and top position of camera image on
image sensor.

Packet size

To change packet size first deactivate
Auto size check box.

O Auto size

Y
w

Deactivate check box to adjust packet
size for isochronous packets (via slider
or combo box).
= Auto size is a SmartView feature,
but not a camera feature, and is
automatically saved in the registry
(but not in the user sets) when
closing SmartView.

Max frame rate

Shows the maximum theoretical frame
rate. See Chapter Calculating frames per
second on page 123.

Table 8: SmartView Edit settings: Format tab

Ctrl 1 tab descriptions

If available, you can do the following:
e Switch on/off the feature, by activating/deactivating the On check box.
e Switch on/off auto function, by activating/deactivating the Auto check

box.

e Do one-push action, by clicking button.

e Adjust the feature manually by moving the slider or changing the values
directly (entering numbers or clicking up/down arrows.)

AVT SmartView for FirePackage V2.3.1
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Check box/combo box/list/slider Description

Target grey level This is the auto exposure. Works in conjunction with auto shutter
J and auto gain.
Target grey level corresponds to Auto_exposure register
0xFOF00804 (IIDC).
Increasing the auto exposure value (aka target grey value)
increases the average brightness in the image and vice versa.

Shutter Adjust the electronic shutter manually. The set value is to be
multiplied by the time base, which can be set here: Check box
J Timebase on page 51
Gain Adjust the gain manually. Gain will change on the fly. The possible
J range depends on the camera model. The value is to be multiplied

by a constant factor which is dependent on the camera model.

A higher gain produces greater image noise. This reduces image
quality. For this reason, try first to increase the brightness, using
the aperture of the camera optics and/or longer shutter settings.

Brightness Adjusting the brightness manually changes the IIDC register
J brightness at offset 800h. This effectively changes the offset in
the image. The range is multiplied by a factor, dependent on the
camera model.

Gamma Switch Gamma off/on
J 0 = Gamma off
1 = Gamma on
This is a non-linear stretching of the darker parts and compression
of the brighter parts in the image to accommodate certain human
and display non-linearities. The actual function used is described
in the camera manual.

When using the LUT feature and the gamma feature pay attention
to the following:

e gamma ON - look-up table is switched ON also
gamma OFF - look-up table is switched OFF also
look-up table OFF - gamma is switched OFF also

look-up table ON > gamma is switched OFF

Table 9: SmartView Edit settings: Ctrl 1 tab
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Check box/combo box/list/slider Description

White balance Only color cameras
J Here you can do manual and automatic white balance. White

balance is applied so that non-colored image parts are displayed

non-colored. From the user's point, the white balance settings are

made in register 80Ch of IIDC V1.3 or IIDC V1.31 (depending on

camera model).

The values in the U/B_Value field produce changes from green to

blue; the V/R_Value field from green to red.

Sharpness Only available for Oscar, Marlin, Pike, Stingray

The color models are equipped with a two-step sharpness control,
J applying a discrete horizontal high pass in the green/Y channel.
See Oscar/Marlin/Pike/Stingray Technical Manual, Chapter
Sharpness.

Table 9: SmartView Edit settings: Ctrl 1 tab

Ctrl 2 tab descriptions

If available (hue/saturation), you can do the following:

e Switch on/off the feature, by activating/deactivating the On check box.

e Switch on/off auto function, by activating/deactivating the Auto check
box.

® Do one-push action, by clicking button.

e Adjust the feature manually by moving the slider or changing the values
directly (entering numbers or clicking up/down arrows.)

Check box / combo box/ list / slider Description

Hue Adjust Hue manually.
J Hue performs a (slight) global shift of all colors in the image.
Saturation Adjust Saturation manually.
J Saturation changes the amount of the coloring from nominal
down to zero or up to 200%.

Table 10: SmartView Edit settings: Ctrl 2 tab
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Check box / combo box/ list / slider Description

Auto-function AOI

This is a feature to limit the area in which parameters for the
auto functions (auto gain, auto shutter, auto white balance) are
calculated to a fraction of the image size. Can be used to
exclude e.g. the sky from the gain/shutter regulations or
perform auto white balance in only a specific subarea of the
image.

Switch on/off auto-function AOI by activating/deactivating
Enable check box. Off uses the whole image size for
autofunction parameters.

Enter values: AOI width/height/left (coordinate) and top
(coordinate). Allowed steps are shown in the fields
X-Unit/Y-Unit.

To highlight the AOI in the image, activate Show AOI check box.

Auto shutter range

Choose standard (Std.) or extended (Extd.) auto shutter range.
Change lower and upper limit to restrict the auto shutter to
operate between these limits and not the whole range. Useful
for applications where a too long shutter time would cause e.g.
motion blurring in the image.

Auto gain range

Change lower and upper limit.

Change lower and upper limit to restrict the auto gain to
operate between these limits and not the whole range. Useful
for applications where a too high gain would cause noise in the
image.

Table 10:

SmartView Edit settings: Ctrl 2 tab
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Ctri3 tab descriptions (only color progressive)

Ctrl3 tab exists in two variants:
e Description for color progressive cameras see below

e Description for color interlaced see Chapter Ctrl3 tab descriptions (only
color interlaced) on page 45

Progressive cameras

Check box / combo box/ list / slider Description

Extra features during debayering These two features (hue/saturation) are only available if camera
transmitting RAW image and SmartView doing the debayering
process, using one of the following algorithms:

o 2x2 YUV422

o 2x2 LCAA

o 2x2 LCAA+V

It effectively changes both hue and saturation during
debayering on the PC.
See Chapter Additional adjustment of hue and saturation on
page 65.
= These features are SmartView features,
but not camera features.

Hue Adjust Hue during debayering on the PC manually.
(values in degrees)
0 : -0 = Hue on this tab is a SmartView feature,

but not a camera feature.

Saturation Adjust Saturation during debayering on the PC manually.
(values in percent)
0 L - = Saturation on this tab is a SmartView feature,

but not a camera feature.

Table 11: SmartView Edit settings: Ctrl 3 tab (progressive cameras)
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Ctri3 tab descriptions (only color interlaced)

Ctrl3 tab exists in two variants:

e Description for color progressive cameras see Chapter Ctrl3 tab descrip-
tions (only color progressive) on page 44

e Description for color interlaced see below

Interlaced cameras

Check box / combo box/ list / slider Description

Advanced white balance For the interlaced color Guppys (Guppy F-038/038 NIR/044/044
NIR) using complementary color filters (Cy, Mg, Gr, Ye) there is
a non-standard (non-IIDC) register for white balance
(0xF10080C4 and 0xF10080C8).

This register is similar to the standard white balance CSR: here
each of the four colors can be controlled independently. See the
four sliders in this table.

@ Note: One-push white balance is not available.

Green/Cyan Adjust advanced white balance manually for
4 e Greenin Format_7 Mode_1 or

0 »12 e Green/Cyan in Format_7 Mode_0
Magenta/Yellow Adjust advanced white balance manually for
Y * Magenta in Format_7 Mode_1 or

0 w1z e Magenta/Yellow in Format_7 Mode_0
Cyan/Magenta Adjust advanced white balance manually for
4 e (Cyan in Format_7 Mode_1 or

0 w1z e (Cyan/Magenta in Format_7 Mode_0
Yellow/Green Adjust advanced white balance manually for
Y ¢ Yellow in Format_7 Mode_1 or

0 w1z * Yellow/Green in Format_7 Mode_0

Table 12: SmartView Edit settings: Ctrl 3 tab (interlaced cameras)
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Section

Trig/10 tab descriptions

Check box / combo box/ list / slider

/1

Description

Trigger

Mode

The following trigger modes may be

available (depending on camera

model: internal/edge mode/level

mode can be:

Ext=external trigger

SW=software trigger):

e Internal (continuous output)

® Edge mode(0)-Ext

® Level mode(1)-Ext

® Progr. mode(15)-Ext aka
Trigger_Mode_15

® Edge mode(0)-SW

® Level mode(1)-SW

® Progr. mode(15)-SW

Beside Internal the other modes

require a signal at the trigger pin of

the I/0 (HIROSE) connector to get an

image.

Polarity

Polarity of trigger signal (depending
on camera model and mode)
Edge mode(0) and Progr. mode(15):

* Falling

® Rising
Level mode(1):
* low act.

® High act.

Multishot counter

4

Choose number of images the camera
will take.

Trigger delay

O On

Delay between trigger signal and
image acquisition

On/off only available, when Edge
mode(0)

4

us

Delay time in ps for exposure start
after trigger signal

Table 13: SmartView Edit settings: Trig/I0 tab
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Section

/1

Check box / combo box/ list / slider Description

Integration enable delay

O On

Delay between integration (shutter)
and output signal integration enable
(IntEna)

v | Hs

Time in ps for delay of integration
enable event (IntEna)

SW Trigger

Trigger button

With edge mode: click on Trigger to
set exactly one trigger signal.

With level/progr. mode:

Click Trigger to start the trigger.
Click Stop Trigger to stop the trigger.

Table 13: SmartView Edit settings: Trig/IO0 tab
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Section

/1

Check box / combo box/ list / slider Description

Input/Output pins

List of all inputs and outputs of a
camera.

The number of inputs and outputs
depend on the camera model.

Mode column

For each pin you can choose one of
the following modes:

Input = (Off/Trigger)

Output =
(Off/Direct/IntegrationEnable/
FrameValid/Busy/FollowInp/
PulseWidthMod/WaitingForTrigger).
Query the camera manual for details
on the signals.

Invert column

This is the polarity bit. The former
Polarity column for the input/output
pins is now called Invert to clarify the
use of this bit. A polarity of low in
former SmartView versions is now read
as Invert:No, meaning the same.

State column

Lists the status of the input/output
pin (Low or High).

Period column

Only available for cameras with pulse
width modulation (see Technical
Manual).

Width column

Only available for cameras with pulse
width modulation (see Technical
Manual).

Debounce column

Enter debounce time in 500 ns
increments.

Example:

3 is equivalent to 3x500ns=1.5us

[0 Poll the I/0 state continually

Activate check box to update the
state of pins every 200 ms.

Software trigger

| Trigger |
| Skop Trigger |

To start software trigger click Trigger
button. It is self cleared, when using
edge mode; must be set back manually
(click Stop trigger button), when
using level mode.

Table 13: SmartView Edit settings: Trig/IO0 tab
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LUT/Shdg. tab descriptions

Note ¢ For a detailed description on LUT see Chapter Working
with LUTs on page 84.
@ ® For a detailed description on shading see Chapter
Working with shading on page 77.
Section Check box / combo box/ list / slider  Description
Lookup tables O LUT operation on Camera-internal LUT on/off
LUT # = Choose camera-internal LUT (both:

for uploading and selecting). There is
one set for data per LUT number.
Therefore LUT data combo box,
Upload button and contents of LUT
editor may change if you select a new
LUT number.

Choose built-in LUT:

* data from the file below

e 3 table for gamma = 0.7

® 3 table for gamma = 0.45

® a table for inversion

® a table for identity

The following two entries are only for

display:

® <empty> means: SmartView has
not written any data into the
camera yet. Therefore SmartView
does not know what LUT data is
currently used by the camera
(LUT cannot be read from cam-
era).

e <modified> is displayed, when-
ever LUT data was modified by
the LUT editor.

Opens the LUT editor with built-in

viewer and displays the uploaded
LUT. For a detailed description see
Chapter Using LUT editor with built-
in viewer: Overview on page 90

LUT data w

Table 14: SmartView Edit settings: LUT/Shdg. tab
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Section

Check box / combo box/ list / slider

/1

Description

Lookup tables (cont.)

Uploads the selected data into the
camera. (Note: The button is colored
to indicate that the LUT data in
SmartView differs from the data in
the camera.)

LUT file [..]

Only available when choosing data
from the file below

Choose directory and file for upload
process.

Import data from column b

starting at b

Only available when choosing data
from the file below

Choose column where LUT is stored
and choose row number where LUT
starts.

Shading correction

O Shading correction on

Shading correction on/off

0 Show shading data as image

Select shading image as camera
output.

shading data from

Builds camera-internal shading
image. Choose number of images to
be averaged (in order to reduce
noise...) for building the shading
image.

(# Flash [ Save ko flash ]

Use option Flash to save/load
shading image in user sets (inside
camera).

Load From Flash

Loads a shading image stored in user
sets (inside camera).

Clear Flash

Clears shading image stored in user
sets (inside camera).

(# File [ Dovwnload & save as File ]

Use option File to save/load shading
image to/from an external file.

Upload From File

Uploads an external stored shading
image.

Shading data file

v L

Choose different external files for
uploading/saving. The combo box
lists recently used shading files (for
upload/save operations).

Table 14: SmartView Edit settings: LUT/Shdg. tab
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Adv 1 tab descriptions

Section Check box / combo box/ list / Description

slider

Extended shutter = Absolute time of exposure in ps.
Settings override the standard shutter
settings (and vice versa). Max. settings

depend on camera model.

Std. shutter timebase |Timebase 2 AVT timebase controls the base factor for the
standard shutter register. Camera needs to
be stopped for changes in this register.
Shutter value (Slider Shutter on page 41) is

multiplied with time base.

Test images Choose one of the camera-internal images as

Active image w ) )
image source. Depending on the camera
model you can choose between different
test images.
See AVT Technical Manuals.
Mirror image [ Horizontal Depending on the camera model you can flip
I Vertical the image horizontally/vertically. This is

done in hardware in the camera.

Table 15: SmartView Edit settings: Adv 1 tab
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Section Check box / combo box/ list / Description

slider

Deferred transport [0 Hold images Deferred image transport is available for
Stingray, Pike, Marlin, Oscar cameras.
Activate Hold images to stop image transfer
to the viewer (SmartView) and store the
image in FIFO.

[0 Fast capture Activates FastCapture mode of AVT deferred
image transport. The sensor is read out at its
maximum speed. Alternatively the sensor is
read out at a speed according to the
transmission settings.

Choose number of images which will be sent

when clicking on [ Sendimages |. Setto 0 to

send all images in FIFO.

# of images to send -

FIFO size Displays size of internal image FIFO in terms
of frames.

FIFO used Lists number of images currently held in
FIFO.

Read(s) image(s) from FIFO and send images

over bus to SmartView.

[ Lock image capture Prevents AVT SmartView from sending ISO-
enable/one-shot command to the camera
when using the black arrows on bottom of
window.

(> ]wa] [m] [£]

With Lock image capture activated the

above buttons prepare SmartView viewer
window without starting the camera (ISO
enable).

IEI IEI With Lock image capture on, clicking on

red arrows (free-run, one-shot) starts
camera and images are captured into FIFO.
|E|Capture images into the FIFO using free-
run mode.

[#1]Capture images into the FIFO using one-
shot mode.

Version information | Microcontroller/Order Number/ | Lists the version numbers and IDs of
FPGA/Serial number firmware (microcontroller/FPGA), the order
number of the camera and the serial number
of the camera.

Table 15: SmartView Edit settings: Adv 1 tab
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Section

/1

Adv 2 tab descriptions

Check box / combo box/ list / Description

Serial port (IIDC-1.31)

slider
Bitrate

Choose bit rate for camera’s RS232 serial
port. It can be used to send and receive data
to and from an external device, connected to
the camera.

Char length

Choose character length for serial input/

v output:
e 7 bits
e 38 bits
Parity Choose parity for serial input/output
3 ®* none
e odd
® even
Stop bits Choose number of stop bits for serial
2 input/output

e 1 stop bit
e 1.5 stop bits
e 2 stop bits

® Serial port off
() Transmitter on
{3 Receiver on

Disable serial input/output of camera
Enable only serial sending

Enable only serial receiving

Enable bidirectional serial input/output

(3 Both on
Transmit Enter text to be transmitted to camera.
Receive Any data which is received by the camera via

RS232 will be displayed here until the buffer
is full.

Table 16: SmartView Edit settings: Adv 2 tab

AVT SmartView for FirePackage V2.3.1
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Section Check box / combo box/ list / Description
slider
Secure image I Enable Only Marlin, Pike or Stingray CCD cameras:
signature (SIS) & available with firmware V3.03 or newer
counters See Marlin, Pike or Stingray Technical
Manual, Chapter Secure image signature
(SIS)

Activate check box for writing time stamp (a
very precise clock), frame counter and
trigger counter data directly into image
(Pike: also additional SIS data). After
activating check box these data are stamped
at a selectable row position left in the
image.

Choose where these data are put into the
image:

Row 0: top of image

Row 1,2,...: rows below top of image

Row -1: bottom of image

Row -2,-3,...: rows above bottom of image

Click to display SIS information (secure

image signature)

Row

4

Only Pike: Enter a user value which will be

User value . .
written into the camera.
Frame Counter P Frame counter and trigger counter ca.n also
be read out asynchronously from registers
Trigger Counter Reset (i.e. not out of image).
Display Activate Display check box for displaying

frame/trigger counter numbers.
Frame counter field displays number of

images taken since clicking on [Reset|.
Trigger counter field displays number of
external trigger events since clicking on

=)

Color [ Color correction Depending on camera model:
Activate check box for using built-in color
correction matrix. For certain camera models
the matrix coefficients can be modified
using Adv3 tab.
Note: It is not an intuitive
@ procedure to change the
coefficients of a 3 x 3 matrix in the
RGB color domain!

Table 16: SmartView Edit settings: Adv 2 tab

AVT SmartView for FirePackage V2.3.1
54



AVT SmartView for FirePackage / / /

Section Check box / combo box/ list / Description

slider

Camera reset (Soft reset | [Initializz Soft reset: camera feature

Click for rebooting the internal

logic in the camera (FPGA) and forcing the
1394 bus to reset.

Click for setting FPGA back to
default values. No reset of the 1394 bus.

User sets (Memory See Technical Manuals, Chapter User
channels) profiles. Used to store/recall custom
settings in/from camera.

Saves current settings in chosen user set
(1..3).

Loads settings from chosen user set (1..3)

Save

without rebooting camera.

Starts the chosen user set (1..3) on next
lﬁﬂﬂﬁﬁlﬂﬂiﬂﬂﬂl
camera start automatically.

Set No. - Choose desired user set number for save/
load/set as default action.

User Set No. 0 = factory setting (can not be
changed)

User Set No. 1..3 = save/load/set as default
actions possible

Table 16: SmartView Edit settings: Adv 2 tab
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Section

/1

Adv 3 tab descriptions

Check box / combo box/ list /

slider

Description

Color correction

Correction matrix
Color correction
iZarrection matrix

Crr | 1025 cgr | 71 Chr| -96 sum is 1000

Crg | -229 Cog | 1371 Chy|-142 sum is 1000

Crb | 57 Cab | -411
Example shows Pike F-032C

Chb| 1354 sum is 1000

Only cameras with color correction and
correction matrix feature implemented
See Pike/Stingray/Guppy PRO Technical
Manual, Chapter Color correction

To change matrix elements first activate

color correction check box on Adv 2 tab.

Change value in each of the nine fields of

correction matrix manually. Enter values

between -1000 and +2000.

1000 means a factor of 1.0

If you want to get back factory settings,

click Reset to default.

The row sum is displayed: Pay attention to
the following:

e The sums of all rows should be equal to
each other. If not, you get tinted
images.

e TIn order for white balance to work
properly ensure that the row sum
equals 1000.

e Each row should sum up to 1000. If
not, images are less or more colorful.

Smear reduction

Enable

Enables disables smear reduction (only Pike)

Software features

] Disable LED functionality

Only Stingray/Guppy PRO cameras
Activate check box to switch off LEDs.

@ Note: During startup of the

Number of digitization taps

camera and if an error condition is
present, the LEDs behave as usual.
Choose number of digitization taps
(only cameras with multi-tap sensors: e.g.
Pike F-1100/1600) and click Apply.

Table 17: SmartView Edit settings: Adv 3 tab
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Adv 4 tab descriptions

(only Stingray)
Section Check box / combo box/ list / Description
slider
Defect pixel correction| Defect pixel correction on Enable/disable defect pixel correction. The
first image is done by the camera itself.
For detailed information see Stingray
Technical Manual, Chapter Defect pixel
correction.
Threshold Via threshold you can define the defect
pixels in an image.
Detect Click Detect to detect the defect pixels. The
number is shown above the Threshold slider.
Save data to flash Saves data to the flash memory.
Load data from flash Loads data from the flash memory.
View/Edit Lets you edit defect pixels manually.

Table 18: SmartView Edit settings: Adv 4 tab

Adv 4 tab descriptions
(Defect pixel correction: only Pike)

For Pike F-1100/1600 and AVT SmartView 1.13 or greater you can edit the list
of defect pixels directly in the camera (Adv 4 tab).

Note For a detailed description see PIKE Technical Manual V5.1.0
or greater, Chapter Defect pixel editor in SmartView.
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Section

High dynamic range
mode
(only Guppy F-036)

/1

CMOS tab descriptions
(only Guppy F-036, Marlin F-131, Guppy F-503, Guppy PRO F-503)

Note To use this feature number of knee points must be greater 0.

Check box / combo box/ list /
slider

(only Guppy F-036)
[0 HDR mode on
Voltage #1

e
w

Voltage #2

Knee points &

Description

For Guppy F-036 see Guppy Technical
Manual, Chapter HDR (high dynamic
range) (Guppy F-036 only)

To use this feature first change number of
knee points to value greater 0.

Then activate HDR mode on check box.
Guppy F-036: In Knee points choose 1 or 2
and enter Voltage value in Voltage #1 (and
Voltage #2).

Table 19: SmartView Edit settings: CMOS tab
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Section Check box / combo box/ list / Description
slider
High dynamic range | (only Marlin F-131) For Marlin F-131 see Marlin Technical
mode Knee points = Manual, Chapter High dynamic range mode

(only Marlin F-131) (Marlin F-131B/C only)
To use this feature first change number of
knee points to value greater 0.

Choose number of knee points: 1, 2 or 3.

HDR mode on Then activate HDR mode on check box.
Marlin F-131: Choose Easy mode or Expert
mode by clicking on the radio button.

Display graph For a graphical on-the-fly representation of
the HDR mode activate Display graph check
box.

253Grey level 2.3x [7.3dB)
221 O

149 O~ Example of

3 knee points

Light intensity

() Easy mode In Easy mode put slider in the desired
position (the knee point values will be set
automatically). An Easy mode value for the
dynamic gain increase in dB will be shown
(7.4 dB in our example).

Example:
0.0de 52.0d8

I
Control your setting in the graph.
= The Easy mode is a SmartView feature,
but not a camera feature.

7.4dE

& Expert mode In Expert mode enter values for Add.time #1
(#2, #3) manually.

Example:

Shutter time  Add, time #1 Add, time #2 Add, time #3  Total Time
21709 1054z % 6998 % | 655 $ 40000
Shutter time and Total time are displayed.
Control your settings in the graph.

Table 19: SmartView Edit settings: CMOS tab
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Section Check box / combo box/ list / Description

slider
DSNU/Blemish pixel | DSNU correction on See Marlin Technical Manual,
correction Chapter DSNU & blemish correction
(only Marlin F-131) DSNU = Dark signal non-uniformity

Close the lens or the aperture so that no
light hits the sensor for DSNU and blemish
correction procedures.

Activate check box to use DSNU.

I Blemish correction on Activate check box to use blemish
correction. This will identify and
compensate for defective pixels by using
intact neighbors.

[0 Show correction data image  |Activate check box for displaying correction
data as image.

Correction data using Builds DSNU/blemish pixel correction image
from the number of images you have chosen

o (possible numbers are 1, 2, 4, 8, 16).

Saves the correction data into the correction
data storage.

[ Save data to flash ]

Loads the factory settings into the

Load data from flash
! ] correction data storage.

T Empties the correction data storage.

Defect Pixel Correction| Defect pixel correction on Enable/disable defect pixel correction.
(only Guppy F-503 For detailed information on defect pixel
and correction see Guppy Technical Manual and
Guppy PRO F-503) Guppy PRO Technical Manual.
The first image is initiated by SmartView
itself.
Threshold Via threshold you can define the defect
pixels in an image.
Detect Click Detect to detect the defect pixels. The
number is shown above the Threshold slider.
Save data to flash Saves data to the flash memory.
Load data from flash Loads data from the flash memory.
View/Edit Lets you edit defect pixels manually.

Table 19: SmartView Edit settings: CMOS tab
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Section

Check box / combo box/ list /

slider

/1

Description

Shutter mode @ Electronic rolling shutter

(only Guppy F-503) & Global reset release shutter

Switch between these two shutter modes.
SmartView shows automatically Format tab
(frame rates and other features may be
changed.)

For detailed information on shutter modes
see Guppy Technical Manual, Chapter
Electronic rolling shutter (ERS) and

global reset release shutter (GRR) (only
Guppy F-503)

Table 19: SmartView Edit settings: CMOS tab

Guppy F503C [C 1, N 0] - AVT SmartView 1.12 [

Format | Ctrl 1

Shutter mode

(%) Electronic rolling shutter

Defect pixel correction

[ ] pefect pixel correction on

Threshald I
40

cirl 2 | ctrl 3 || Trig/o || LuT/shdg. [ Adv 1 | Adv 2 | CMOS

(") Global reset release shutter

Save data to flash ]

[Lu:uad data from flash

1717 defect pixels mean value: 21
0 B
96
View [ Edit

Don't auto hide

> ][w] [m] [£]

Figure 4: Example of CMOS tab for Guppy F-503
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Direct register access window

Note The height of this window can be adjusted, but not the width

(although double arrows are shown).

Definition Direct access window is a tool to write data into registers directly and read
out data from registers directly (in hex code).

Check box / combo box / list Description

Register Lists all accessible registers by
the clear names.

W

Address The address of the chosen register
is displayed immediately.
Alternatively you can enter an
address in hex code manually.

Data Lists the data that is read from or
written to the chosen register.

Read Reads data from chosen register.
Write Writes data in chosen register.

List # column Counts the number of read/write
actions.

rw column Displays type of action:
rd=read
wr=write

Address column Displays the address of read/write
action in hex code.

Value column Displays the value of read/write
action in hex code.

Table 20: Smart View Direct access window: descriptions
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Debayering

Figure 5: Debayering:

Hue/Saturation:
Adjust

In this chapter you will find descriptions how to operate AVT cameras with
the SmartView software. The most important camera functions are explained
and you learn how to use these functions effectively with SmartView.

algorithms
= These algorithms are SmartView features, but not camera features.

Conditions

® Only PC debayering (via SmartView)
® Only color cameras

e Works only in RAW8/RAW12/RAW16/Mono8 mode (depending on spe-
cific camera type); in RAW12/RAW16 mode only 2x2 algorithm available

Where to find
SmartView: || Edit settings > Format tab

Pike FZ10C [C 0, N 191644770] - AYT SmartYiew 1.8
Format |cirl 1 | Crl2 |l 3 | Trig/1o | LUTjShdg. | Adv 1 | adv 2 | adv 3|

Fixed & wariable modes. ..

Formak Colar 150 speed Debayering
320x240 Monog --imvalid -- | (5100

640450 Ylv411 5200

S00xa00 Y422 2400

1024x768

12560x 960

Tlisda 22 YIY4ZZ

2w LTAA

F7 mode 4
F7 mode 5
F7 mode &

"Débayering:

150 chanmel

type
Example of choosing type (Pike F-210C)

[w] auta chn,

Only RAW8 formats: additional adjustment of hue and saturation possible
(using methods YUV422/LCAA/LCAA+V):

SmartView: || Edit settings > Ctrl3 tab (color progressive)

Guppy FO46C [C 1, N 198329442] - AVT SmartView 1.8
Format | el 1 |tz | C3 Trigi1o| LUTShdg. | Adv 1 | Adv 2|

Extra Features during debayering

Hue

Saturation

Figure 6: Hue and saturation: Example of additional adjustment (Guppy F-046C)
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Description

The following debayering algorithms are available (depending on specific
camera type):

Debayering  Choose type Description Advantages (+) and
algorithm disadvantages (-)
none none No debayering
2x2 2x2 debayering is done on a 2x2 pixel |+ fastest (lowest CPU con-
basis sumption) algorithm
- color fringe
2x2 mono Showing only mono image (lumi- + no color fringe (b/w image)
nance Y only) of 2x2 debayering - no color information
3x3 3x3 Debayering is done on a 3x3 pixel |+ less color fringe
basis - less resolution
- more CPU consumption
2x2 2x2 YUV422 |Same algorithm as in AVT Marlin + faster algorithm compared to
cameras (produces the same color LCAA an LCAA+V
output as Marlin in YUV422 mode). | _ " 1 ovizontal color fringe
Color low-pass filtering with two hor-| than LCAA
izontally neighboring pixels
2x2 LCAA LCAA = local color anti-aliasing + less horizontal color fringe
Color low-pass filtering with four - vertical color fringe
horizontally neighboring pixels
2x2 LCAA+V | LCAA+V = local color anti-aliasing + less horizontal and less ver-
including vertical color smoothing tical color fringe
Color low-pass filtering with a win- |- slowest algorithm (highest
dow of four horizontal and two verti-| CPU consumption)
cal pixels

Table 21: Description of debayering algorithms
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The following BAYER patterns are available (depending on specific camera

type):

BAYER pattern Description

auto. pattern Default

RGGB Use one of these patterns, if e.g. older SmartView

GRBG versions use the wrong BAYER pattern.

CBRC The first two letters are of 1st row of sensor, the
R last two letters are of 2nd row of sensor.

BGGR R=red; G=green; B=blue

Table 22: Description of BAYER patterns

Additional adjustment of hue and saturation

® The following three types (YUV422, LCAA, LCAA+V) convert the trans-
ported RAWS8 image to the YUV space.

® Here the (different) low-pass filtering of the color information (U and V
values) is done to reduce color fringe at edges.

® Hue and saturation require intensive computations in YUV. If hue is 0
(no hue rotation) and saturation 100 (=100%) a more efficient back
transformation is done.

e After that conversion to BGR space (Windows RGB) is done.

AVT SmartView for FirePackage V2.3.1
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Advanced white balance (only Guppy color

interlaced)

Conditions

e Only Guppy color interlaced cameras
e  Only Format_7 Mode_0 and Mode_1

Where to find

Only Guppy (interlaced): adjustment of advanced white balance possible:
SmartView: Main window: [g&| Edit settings - Ctrl3 tab
Guppy FO38C NIR [C 1, N 198526050] - A¥T SmartYiew 1.8

Format | Ctrl 1 [ ctrl2 | CErl3 | Trigf1o || LUT/Shdg. | Ady 1 | Adv 2

Advanced white balance

GreenjCyan Advanced white balance:
Magenta/ellow | Adj USt

CyanfMagenta Green, Magenta,
Cyan, Yellow

‘ellowGreen

Figure 7: Advanced white balance: Example of adjustment G, Mg, Cy, Ye (Guppy F-038C NIR)

Format_7 Mode_0

Description

Guppy interlaced cameras use color sensors with complementary color filters
(Green, Magenta, Cyan and Yellow). This sensor type is not covered by IIDC
specification.

White balance requires a set of advanced registers to allow adjustments. In
addition, there are two different Format_7 modes available:

e Mode_0 which effectively bins two rows and

e Mode_1 which is a frame integration mode

Thus Mode_0 and Mode_1 perform differently from the point of white balanc-
ing.

In Format_7 Mode_0 (field integration, two lines are binned during sensor
readout) advanced white balance is adjustable for each of the individual
(binned-) pairs:

e Green/Cyan

Magenta/Yellow

Cyan/Magenta

Yellow/Green

AVT SmartView for FirePackage V2.3.1
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Format_7 Mode_1 In Format_7 Mode_1 (frame integration, two lines are binned in the soft-
ware) advanced white balance is adjustable for each of the individual com-
plementary colors:

® Green

® Magenta
e (yan

e Yellow

There is no one-push function. Set the camera to auto to perform continu-
ously white balance or switch auto off after the correct white balance is
achieved.

AVT SmartView for FirePackage V2.3.1
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Saving and streaming images

Conditions

e Hard disk or network drive with enough space

e Recording: Make one or more images. Then the recording options are
available.

e Use deep images: only available with camera models having MONO12/16
(monochrome models) or RAW12/16 (color models)

Where to find

SmartView: Main window: File > [ Save

SmartView: Main window: File - Save as...
SmartView: Main window: File > Recording options
SmartView: Main window: File > Use deep images

FIE Camera Wiew Extras  Help

W Save Chrl+3
Sawve as... F1z
Recording options. ..

IUse deep images  Chrl+Shift+P

Exik Ak

Figure 8: Where to find: Saving and streaming images

Description

Saving images to hard disk or network drive

To save a single image to hard disk or network drive, use the File > Save
as... command, choose directory and file name on your hard disk or network
drive and choose the file format. The following file formats are available:

e BMP (*.BMP, *.DIB, *.RLE)

o JPEG (*.JPG, *.JPEG, *.JPE, *.JFIF)

e GIF (*.GIF)

e TIFF (*.TIF, *.TIFF)

e PNG (*.PNG)

When saving 16-bit images with Save as... command the ending *.raw is set

automatically (although you can choose bmp, jpeg, gif, tiff, png only in the
dialog) to the file name. The reason is the following: Windows operating sys-
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tem is unable to display more than 8 bit. For display in SmartView the images
are reduced to the upper 8 bit. Other image processing tools must be able to
handle images with more than 8 bit.

For more information on deep images see Chapter Using deep images (only
MONO12/16 mode or RAW12/16 color mode) on page 71.

File format Compressed/lossless  Description

BMP Uncompressed, lossless |Best file format for all your applica-
tions. All image processing tools can
open BMP files.

JPEG Compressed, lossy JPEG is a lossy format and file size is
much smaller than bmp. Be aware
that you may loose details in the
image.

GIF Uncompressed, lossless |Use GIF only if it is acceptable to
store image only with 256 colors.

TIFF Uncompressed, lossless |Tagged image file format, used in the
printing industry. Use TIFF only if
required; e.g. your image processing
tool works only with TIFF format.
PNG Compressed, lossless PNG has compression and works loss-
less.

Table 23: Description of file formats

When the file exists, you can choose File > [ Save or just click on the [
button to overwrite the file.
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Streaming images: recording options

Note Precondition: First make one or more images, otherwise the
Recording options menu is not available.

@ Streaming is not meant in the sense of a video file. You will
have to use third party software to do offline conversion from

the streamed images to a video file.

Alternatively Streampix software from www.norpix.com can
be recommended for directly recording to a video file.

To continuously save images to hard disk or network drive in a streaming for-
mat, use the File > Recording options and configure your recording in the
Recording options window (seeTable 24: Recording options window:
Descriptions on page 71).

Recording options

File name options
Current File name
| | [ Select. .. ]
Mumber of digits
Processing options
Record every . Frame
( O, | [ Cancel ]

Figure 9: Recording options window

Note Be aware that it is not guaranteed that each and every image
from the camera is finally recorded to disk. SmartView is not
@ optimized for unlimited recording.
You may improve the performance by setting the Frame buff-

ers in Format tab of SmartView (see Frame buffers on page
39) to the maximum your system (and main memory) allows.
Usually this amount of images can be recorded without loss
of frames.

AVT SmartView for FirePackage V2.3.1
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Section

Check box / combo box/ list / slider Description

File name options

Current file name After choosing number of digits click
, choose directory, enter
file name, file format and click on
Save.

First choose number of digits for file
name of all images in streaming for-
mat.

Default: 5

Example:
recording_test00000.bmp
recording_test00001.bmp

Number of digits & S

recording_test99999.bmp

Processing options

Choose if you want to record:
® every frame (1)

® every second (2)

every third (3)

Record every | % 1| . frame

every nth (n)

Definition

Table 24: Recording options window: Descriptions
To start recording click on | | .

Using deep images (only MONO12/16 mode or RAW12/16
color mode)

Deep images mean: in SmartView, 16 bits are used for storing and processing
the image, if the depth of the sent images is larger than 8 bits.

ALl AVT models except for color Marlin models are capable of sending either
MONO16 or RAW16 images. Only certain Pike/Stingray/ Guppy / Guppy PRO
models are also able to transport images in AVT specific Packed 12-Bit
Modes called MONO12 and RAW12.

Depending on the camera the significant bits will be between 8 and 16 bits.
The bit depth is MSB-aligned, that means a 10-bit image in the 16-bit format
appears to have the same brightness as a 12-bit image, but the 12-bit image
contains 2 more LSBs important for the finer grey-level details in an image.
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Availability depending on camera model:

Camera model Deep images available?  Advantages (+) and
disadvantages (-)

All camera models which have the following formats: | Deep images have the following advantages (+)
MONO12/RAW12 or MONO16/RAW16 and disadvantages (-)

support deep images. + images with enhanced dynamic

- Windows operating system is unable to dis-
play more than 8 bit. For display in
SmartView the images are reduced to the
upper 8 bit. Other image processing tools
must be able to handle images with more
than 8 bit.

Table 25: Which cameras can use deep images?

For cameras with available deep images (MONO12, MONO16, RAW12 or
RAW16) click on
File > Use deep images to use images with more than 8 bits.

Activating/deactivating deep images is stored automatically when closing
the window.

Enhancements during deep image support are:

e Extended histogram: activating/deactivating deep images changes dis-
play of histogram instantaneously

e Tooltip pixel values are adjusted.

e Saving 16-bit images is possible: with Save as... command the ending
*.raw is set automatically (although you can choose bmp, jpeg, gif, tiff,
png only in the dialog) to the file name.

e Recording with 16-bit images is also possible.

Note Saving images in deep image format, the file format is RAW,
which means without header or trailer, as coming from the

@ camera.
The higher byte comes first (the so called big endian format)
and the assembled pixel value is MSB-aligned. That means:
Unused lower bits are zero.

Example: a sequence of two 16-bit pixel ,7F FO FE 50” of a
12-bit image refers to ,,07FF OFE5” (equals ,2047 4069” in
decimal) values of the ADC.

AVT SmartView for FirePackage V2.3.1
72



Operating AVT cameras with SmartView / / /

Caution Working with deep images, more processor power is needed:

/ The viewer may be slower leading to dropped frames.

Loading and saving camera settings as XML
files

Conditions

® To save and load camera settings to and from an XML (eXtensible
Markup Language) configuration file, the MSXML parser must be
installed on your system.

® Msxml3ger.msi: Installation file for the MSXML parser, version 3 service
pack 4, German. For information or other languages see
http://www.microsoft.com/downloads

® For quick read/write settings you first must create/save an xml file as
standard xml file (Select Settings file... see below)

Where to find

File M= Yiew  Extras  Help

= = Free-run Alt+R i - @l El e 7

B, Mulki-shat Alb+r
M Cne-shok alk+13

Settings Settings dialog. . Alk+E

] Direct access dislog...  Al+D

Eﬁ Quick Read Settings  Chrl+3hifk+R,

Opkions
ﬁ Quick \Write Setkings  Chrl+Shift -+

Select Settings file. ..

Read Settings from external file. ..

Wyrite Settings to external File. ..

Search For camera by GUID
Figure 10: Where to find: Loading and saving camera settings as XML files

Camera > Settings - Read settings from external file...
Camera > Settings > Write settings to external file...

AVT SmartView for FirePackage V2.3.1
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Camera > Settings > Select Settings file...
Camera - Settings > 4 Quick Read Settings
Camera - Settings > #§ Quick Write Settings

Description

Most of the configurations of cameras and features in SmartView can be
saved on your computer in an XML file. Save your most used configurations
in different XML files. This gives you the advantage to choose quickly
between different settings.

For very quick loading/saving of one special setting you can use the Select
Settings file... command and then the

® Quick Read Settings &4 button or
® Quick Write Settings £% button

As an alternative save your camera settings as user settings in the camera.
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Working with the histogram function
(SmartView feature only)

= The histogram function is a SmartView feature,
but not a camera feature.

Conditions
e Minimum size of histogram window is 256x128.
e Using deep images, histogram will show values up to 16 bit.

Where to find

View - Additional information 2> Histogram
(or use short key: Ctrl+Shift+H)

File  Camera Extras Help

& & [v ] oobar

Skatus bar

Set display size to
Additional infarmation 3 @4 Coordinates

Disable display of image Zoordinates/Pixel values
' Chrl+Shift+1

G Imane info

) Zoom in Al -
A Histogram  Crl+-Shift+H
'El Zoorn ouk Ale4+"-"
Set zoom=1 Al Cerl4--"
St maimunn 2oom Ale+Cerl4+" 4"

Resize view on format change

Always scale image bo window — AlE+3

Reset position of setkings dialog

Figure 11: Where to find: Histogram

Description

A histogram shows the brightness distribution of an image (e.g. in an 8-bit
image there will be 256 levels of brightness ranging from 0...255 with 0 as
darkest and 255 as brightest value). The sum under the curve is equal to the
total amount of pixels. Use the histogram for analyzing and optimizing
brightness distributions.

e Monochrome cameras show one red curve in the histogram
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® Color cameras show three curves (red, green, blue) in the histogram

e Interlaced cameras show four curves (red, green, blue, yellow) in RAW
mode and three curves with debayering (red, green, blue)

Marlin F201C {C0,N0) - Histogram

o<

number of pixefs
at most freque
value

x-position of Max.

middle of x-axis

Figure 12: Example of histogram (Marlin F-201C)

Histogram element Description

X axis Available values:

8-bit image: 0...255

12-bit image: 0...4095 (Oscar)

14-bit image: 0...16383 (e.g. Pike Mono16)

16-bit image: 0...65535 (e.g. Oscar with 16 images or Pike with 4
images; both in HSNR mode)

y axis Number of pixels with value at x axis

Max: Number of pixels at most frequent value (the corresponding x value
is marked with an additional vertical black line: x-position of Max.)

Table 26: Description of histogram
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Histogram element Description

127 (8-bit)

Middle of x-axis

255 (8-bit)

Maximum x value

Table 26: Description of histogram

Using histogram
The following 3 examples illustrate how to use the histogram function:

1. Experiment how the histogram changes on opening/closing aperture:
- Open aperture: curve(s) move to right side
- Closing aperture: curve(s) move to left side

2. Manual white balance (e.g. single-color/monochrome surface):
- Consider green curve as reference

- Adjust UB slider of white balance so that blue curve overlaps green
curve

- Adjust VR slider of white balance so that red curve overlaps green
curve

- Manual white balance done

3. To get a feeling for contrast of image:
- If an image has little contrast, histogram will show Gaussian like
curve(s) very likely.
- If an image has very high contrast, histogram will show much more
irregular curve(s).

Working with shading

Definition

Shading correction is also known as flat-field correction. It is effectively a
multiplicative correction of each pixel. The cameras perform this task in
hardware, thus not consuming any CPU power or delaying the image. In order
to generate the correction factors per pixel, only an offline task in the cam-
era does all the job.

Upon generation of the shading image in the camera, it can be uploaded to
the host computer for non-volatile storage purposes.

With the Pike, you are now able to store your generated shading data in flash
memory inside the camera, allowing you to calibrate your imaging setup once
under controlled conditions and then just load the stored shading data with
one command after camera startup without having to transfer data from the
PC to the camera.

For this, you are now able to switch the external source/destination from
“file” (like it was possible before) to “flash”, allowing you to store to flash,
load from flash and to clear the flash instead of downloading and saving
shading data to a file or uploading from a file.
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Configure

shading correction|

Additional information

For additional information on the shading correction feature read the fol-

lowing chapters:

e Oscar Technical Manual, Chapter Shading correction

e Marlin Technical Manual, Chapter Shading correction

e Pike Technical Manual, Chapter Shading correction

e Stingray Technical Manual, Chapter Shading correction

Conditions

® (scar cameras

e Marlin cameras

e Pike cameras

e Stingray cameras

® (Guppy cameras have no shading correction)

® (Guppy PRO cameras have no shading correction)

Where to find
SmartView: |gf| Edit settings > LUT/Shdg. tab

Pike FZ10C [C 0, N 191647362] - AYT SmartYiew 1.8
Format |t 1 |l 2 | Cerl 3 | Trigito| LUTIShda. |ady 1 | adv 2 | adv 3|

Lookup tables

|:| LUT operation on LT # _
LUT data | <empty> v

LUTle | LUT_Pike_Gamma_040_150.csv [

Import data From column | Cal B starting at | Row 2

Shading correction
Shading correction on []show shading data as image

shading data from | 256 imagelsy

[ Download & save as File ] [ Upload From File ] Clear Flash

{3 Flash
(%) File

Chading data file |D:'|,F‘ru:ugramme'l,.ﬁ.llied Yision Technologies\FirePackar |E])

[#] Don't aute hide IEI EI IEI IEI

Figure 13: Shading correction: Example (Pike F-210C)
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Usage

Description

Shading correction is used to compensate for non-homogeneities caused by
lighting or optical characteristics within specified ranges.

To correct a frame, a multiplier from 1...2 is calculated for each pixel in
1/256 steps: this allows for shading to be compensated by up to 50%.

Besides generating shading data off-line and downloading it to the camera,
the camera allows correction data to be generated automatically in the cam-
era itself.

Note For conditions and special features depending on the camera
family/model see the Technical Manuals listed in Chapter

@ Additional information on page 78.

There are two storing possibilities:
e After generating the shading image in the camera, it can be uploaded to
the host computer for nonvolatile storage purposes.

® The shading image can be stored in the camera itself. (Pike only)

The following pictures describe the process of automatic generation of cor-
rection data (Pike F-032C). Surface plots and histograms were created using
the ImageJ program.
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255.0

surface plot

0.0

oo’

histogram

B ]
0 256

Count: 307200  Min: 79
Mean: 135.337 Max. 19
StdDev. 30.497 Mode: 88 (4200)

Figure 14: Shading correction: Source image with non-uniform illumination

® 0On the left you see the source image with non-uniform illumination.

e The surface plot on the right clearly shows a gradient of the brightness
(0: brightest > 255: darkest pixels).

e The histogram shows a wide band of gray values.

By defocusing the lens, high-frequency image data is removed from the
source image, therefore its not included in the shading image.

How to prepare for shading image

Shading correction compensates for non-homogeneities by giving all pixels
the same gray value as the brightest pixel. This means that only the back-
ground must be visible and the brightest pixel has a gray value of less than
255 when automatic generation of shading data is started.

It may be necessary to use a neutral white reference, e.g. a piece of paper,
instead of the real image.

To generate a correction image do the following:

AVT SmartView for FirePackage V2.3.1
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1. In SmartView main window click Edit settings - LUT/Shdg. tab

2. In the Shading correction section activate [v] Shading correction on
check box.

Activate [v] Show shading data as image check box.

4, Choose the number of images ~ | to use for building the shad-
ing image (shading data). The recommended number of images for shad-
ing correction is listed in the table below.

Camera type Recommended number of images for shading correction

Oscar 4, 8,16
Marlin 4,8, 16
Pike 2,4,8,16, 32, 64, 128, 256

Table 27: Recommended number of images for shading data

5. Click on .
The automatic generation of shading data is started. The camera pulls in

the number of images which were set in the combo box. An arithmetic
mean value is calculated from them (to reduce noise).

After this, a search is made for the brightest pixel in the mean value
frame. The brightest pixel(s) remain unchanged. A factor is then calcu-
lated for each pixel to be multiplied by, giving it the gray value of the
brightest pixel.

All of these multipliers are saved in a shading reference image. The
time required for this process depends on the number of frames to be
calculated and on the resolution of the image.

Note For conditions and special features depending on the camera
family/model see the Technical Manuals listed in Chapter

@ Additional information on page 78.

How to load a shading image out of the camera

Two saving mechanisms are possible:

e Saving shading reference image to flash (currently only Pike family)

® Saving shading reference image to file (all camera models with shading
correction)

e Shading images can also be generated or modified with image process-
ing software. You can use this mechanism to overlay symbols or gener-
ate a cross hair in the image by simply generating a ,synthetic shading
image” with the symbol or the cross hair.

AVT SmartView for FirePackage V2.3.1
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For saving to file ...

For saving to flash ...
e Choose (& Flash.

e Choose (& File.

e (lick [ Save ko Flash J . e (Click [Du:uwnlu:uad f save as file J .
* Click [...] , choose directory and enter file
name.

The shading reference file is saved...
in an external file

internal into flash memory

Table 28: Saving shading reference image to flash or data file

6. Focus the lens again.
The image below will be seen, but now with a considerably more uni-

form gradient.

255.0 |

surface plot

histogram

%

0 256

Count: 307200  Min: 139
Mean: 157.039 Max: 162
StdDev: 2.629  Mode: 158 (84449)

Figure 15: Example of shaded image

e 0On the left you see the image after shading correction.

AVT SmartView for FirePackage V2.3.1
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e The surface plot on the right clearly shows nearly no more gradient of
the brightness (0: brightest = 255: darkest pixels). The remaining gra-
dient is related to the fact that the source image is lower than 50% on
the right hand side.

e The histogram shows a peak with very few different gray values.

How to load a shading image into the camera
To load a generated correction image back into the camera do the following:
1. In SmartView main window click Edit settings = LUT/Shdg. tab.

For loading from flash ... (inside camera) For loading from file ... (outside camera)

In the Shading correction section choose ...
e Choose & Flash. e (Choose (@ File.

e (lick | Loadfrom flash | . e  (Click | Upload from file | .

* Click [...] , choose directory and enter file
name.

The shading reference file is uploaded...

from flash memory inside camera ‘ from external file outside camera

Table 29: Saving shading reference image to flash or data file

AVT SmartView for FirePackage V2.3.1
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Working with LUTs

Definition

Configure
look-up tables
(LUT)

In image processing, look-up tables are often called LUTs, and they map

index numbers to output values.

Conditions
e All AVT cameras have LUT feature.

Where to find

SmartView: Main window:

B Edit settings > LUT/Shdg. tab

Pike F210C [C 0, N 3564569834] - A¥T Smart¥iew 1.8

Format || Ckrl 1
Lookup tables

|:| LUT operation on LT # _
LUT data |a kable For inversion v |

LUIT File | LUT _Cscar_Caonkrast, csw | L

Crrl 2 | el 3 || TrigiIo | LUT/Shdg. |adv 1 || Aadv 2 || ady 3

\ Irnport data From calurnm | Cal O starting at | Row 2 )
Shading correction
[]shading correction an Show shading data as image
shading data from |2 image(s) L
) Flash
®Fi [ Diownload & save as file ] [ Uplaad From File ] Clear flash
ile

Shading data file |D:'|,F‘ru:ugramme'l,.ﬁ.llied Yision Technologies\FirePackar |E]

[#] Don't aute hide IEI EI IEI IEI

Figure 16: Look-up tables (LUT): Example (Pike F-210C)

AVT SmartView for FirePackage V2.3.1
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How many?

Usage

Example

Gamma LUT

/1

Description

Depending on the model AVT cameras provide from 1 up to 63 user-defined
look-up tables (LUT).

Camera type ... has how many LUTs? Description

Stingray 1 The LUT # starts always

Pike 16 (# 0-15) with 0.

Guppy PRO 1 Camera types having

G 1 only one LUT: the LUT #
uppy cannot be changed.

Marlin 1

Oscar 1

Table 30: Number of LUTs depending on camera type

The use of one LUT allows any function (in the form Output = F(Input)) to be
stored in the camera's RAM and to be applied on the individual pixels of an
image at run-time.

The address lines of the RAM are connected to the incoming digital data,
these in turn point to the values of functions which are calculated offline,
e.g. with a spreadsheet program.

This function needs to be loaded into the camera's RAM before use.

One example of using an LUT is the gamma LUT: see Chapter Using
SmartView’s built-in LUTs on page 87.

The gamma LUT is known as compensation for the nonlinear brightness
response of many displays e.g. CRT monitors. The look-up table converts the
incoming bits from the digitizer to outgoing bits (for values see following
table).

Camera type

incoming ... bits

outgoing ... bits

Stingray 14 the most significant 12
bit of the 14 bit are
used and further down

converted to 10 bit
up to 14

the most significant 12
bit of the 14 bit are
used and further down
converted to 10 bit

Guppy 10 8

Pike 14
Guppy PRO 14

Table 31: Gamma LUT: incoming/outgoing bits

AVT SmartView for FirePackage V2.3.1
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Camera type incoming ... bits outgoing ... bits
Marlin 10 8
Oscar 12 8

Table 31: Gamma LUT: incoming/outgoing bits

Using AVT’s spreadsheet LUTs (camera family dependent)

For each camera family AVT delivers specialized spreadsheets with a variety
of LUTs which you can use immediately.

To use AVT's spreadsheet LUTs do the following:

1.

Choose data from the file below in the LUT data combo box, click [... ]
and choose directory and LUT file you like to use. (Example:
LUT_Pike_Gamma_040_150.csv. Description: see table below. Or use
your own *.csv file.).

- All functions in the delivered AVT ...Gamma_040_150.csv file start
in row 2 (first row = header row). The first look-up table with
gamma=0.4 is Col B. The steps between two columns is 0.05. So
gamma=0.9 for example is Col L.

- All functions in the delivered AVT ...Contrast.csv file start in row 2
(first row = header row). The first contrast table with 0.25 is Col B
and the last contrast table with 4 is Col Q.

Caution If using the LUT editor (Chapter Using LUT editor with built-

in viewer: Overview on page 90) only the chosen column is

/ displayed and on saving the modified LUT you loose all other

2.

columns.

Therefore: If you want to work with the delivered AVT
...Gamma_040_150.csv file and the delivered AVT
...Contrast.csv file:

Never use the Save button in the LUT editor, unless using
a new file name.

From the two combo boxes w | choose column (example: Col B)
and row (example: Row 2) for the function to be applied.

Click . (Note: The button is colored to indicate that the LUT
data in SmartView differs from the data in the camera.)

The chosen LUT is uploaded to the camera. The button changes to
, to indicate that the LUT data in SmartView is the same as
in the camera.

To get a feeling how the LUT looks like click .
The LUT editor opens and a graph of the chosen LUT is displayed.

AVT SmartView for FirePackage V2.3.1
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Note Because AVT camera families have different bit depths there
is a need for different LUT files (see the following table).

@ As examples AVT delivers spreadsheet LUTs for each camera
family:

e (Gamma tables
¢ (Contrast tables

Camera type ... is delivered with LUT files Description
Stingray LUT_Stingray_Gamma_040_150.csv ...Gamma_40_150.csv
LUT_Stingray_Contrast.csv provides gamma tables (gamma func-
Pike LUT_Pike_Gamma_040_150.csv tions with gamma 0.4 up to 1.5, using
i steps of 0.05)
LUT_Pike_Contrast.csv
...Contrast.csv
Guppy PRO LUT_Guppy_PRO_Gamma_040_150.csv

provides LUTs for increasing or decreas-
LUT_Guppy_PRO_Contrast.csv ing the contrast for an image. Each of
Guppy LUT_Guppy_Gamma_040_150.csv them has 16 tables with contrast values
ranging from factor 0.25 to factor 4. A
factor of 4 means that the gradient in

LUT_Guppy_Contrast.csv

Marlin LUT_Maan_Gamma_040_150.CSV the middle of the LUT is Steeper by a
LUT_Marlin_Contrast.csv factor of 4.
Oscar LUT_Oscar_Gamma_040_150.csv

LUT_Oscar_Contrast.csv

Table 32: Description of LUTs depending on camera type

Using SmartView’s built-in LUTs

SmartView has the following LUTs for using without any (external) *.csv files:
See Table 33: Description of LUTs available in SmartView on page 88.

To use them do the following:

1. Choose any of the built-in LUTs (a table for...) in the LUT data combo
box and choose a LUT # where this LUT will be written to.

2. CL]Ck Upload [

The chosen LUT is uploaded to the camera. The button changes to

, to indicate that the LUT data in SmartView is the same as
n the camera.

3. To get a feeling how the LUT looks like click .
The LUT editor opens and a graph of the chosen LUT is displayed.

In the following table you find example graphs (Pike F-210C) for
SmartView’s built-in LUTs.

AVT SmartView for FirePackage V2.3.1
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Name of LUT (SmartView) Description Display LUT
a table for gamma = 0.7 |Table with the following
function:

16384 = ~

Output=(Input)®’

8192

T o T A
8192 16384

a table for gamma = 0.45 | Table with the following
function:

Output=(Input)%4> E

@
iy
=3
=
|
>

8192

T
8192 16384

Table 33: Description of LUTs available in SmartView

AVT SmartView for FirePackage V2.3.1
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Name of LUT (SmartView) Description Display LUT
a table for inversion Table with the following
function:

16384 =

The identity graph is mir-
rored at the middle axis.

8192

8192 16384 v
< >
a table for identity Table with the following
function:
16384 — ~

Output=Input E

8192

T A T
8192 16384 »

- T—

< ¥

Table 33: Description of LUTs available in SmartView

AVT SmartView for FirePackage V2.3.1
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Using LUT editor with built-in viewer: Overview
Where to find

Main window: || Edit settings > LUT/Shdg. tab >

Note e Requirements for display of histogram and Preview but-
ton:

@ - 12-bit or 16-bit mode (Raw or Mono)
- one acquired image in one of this modes
- stop image acquisition before opening the LUT edi-
tor

® By closing the LUT editor, the original image is
restored.

AVT SmartView for FirePackage V2.3.1
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The following screenshot shows the main elements of the LUT editor:

Graph window with two color bars, (histogram)
and scroll bars Reduce 2x

Magnify 2x Zoom to Zoom factor
current selection

AL

16384 =
E Zoom
= CUNEY the graph
é (L7 File Save
= [T _Pike_Gamma_p40_t50.csv | [ LUT data
E k add ¥ values toa fi le
. rGri|:| Paints )

8192 = Edit Mode: Edit modes
E = Move Along Slope Move Freely for
E Mave J Edit Paint grip points
5 > s, [ |
E f<election )
= Replace selection with Modify data
B |Gamma v| Ceet J | within the
E Gamma factor selected

QI I i N o3 region
8192 16384 o o J

k i T - i| Preview .
Undo Redo
Edit values

manually Start with 2 grip points
and linear function

On-the-fly preview
in SmartView window

Figure 17: LUT editor with built-in viewer

AVT SmartView for FirePackage V2.3.1

91



Operating AVT cameras with SmartView

Window element

Graph window

Description

e shows LUT data as graph

e With mouse cursor inside
graph window, dotted lines
in X and Y axis show posi-
tion of associated LUT data
value. Exact values are dis-
played in the lower left cor-
ner of graph window.

X=....
V=....

/1

Examples, controls, buttons

Example of dotted lines and
exact x and y position:

I
: 8192

,

<

x=1046
y=2659

Example of graph window
Pike F-032C

M Pike FO32C fiber (CO, NO) - LUT Editor

16384 =

8192

8192 16384 o

e T

< >

Color bar
(below graph: horizontal and at
right side graph: vertical)

Shows each output value as a
grey color

e (0 is shown as black

®  maximum value that the
current camera supports is
shown as white

Example of horizontal color bar:
Minimum value 8192

T

<

15334/ Max.
value

|
*

Table 34: LUT editor: window elements

AVT SmartView for FirePackage V2.3.1
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Window element

Description

/1

Examples, controls, buttons

Histogram

Shows a histogram of the image
with the applied LUT (only for
12-bit or 16-bit mode in Raw or
Mono)

Example of histogram Pike F-032C:

b . e

Scroll bars

Use the horizontal and vertical
scroll bars for scrolling the graph
when it is zoomed.

Controls for zooming the graph

Use these buttons to zoom in/
out the graph or the current
selection of the graph.

Zoarm

& & Q

2:1

Controls for saving the LUT data
to a file

Enter file name or choose already
existing file to save LUT data.

When deactivating

O add X values check box

the X value column will not be
saved in the *.csv file.

N

Caution: If working
with multi-column
*.csv files: Never use
the Save button in
the LUT editor, unless
using a new file
name. Only the dis-
played column is
saved, all other col-
umns get lost.

LUIT File
LUT_Pike_Gamma_040_150.c54w

L]

add ¥ values

Table 34: LUT editor: window elements

AVT SmartView for FirePackage V2.3.1
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Window element

Controls for editing grip points

Description

On start-up of LUT editor there
are already 2 so-called grip
points set which are connected
with a line (linear function). You
can add/delete/move grip
points.

There are two moving methods:
Move Along Slope and Move
Freely (default). Additionally
you can enter position and value
for each grid point manually.

For details see:

e (hapter LUT editor: How to
add a grip point on page 98

e (hapter LUT editor: How to
remove a grip point on page
99

e (Chapter LUT editor: How to
move/edit a grip point on
page 99

/1

Examples, controls, buttons

Grip Paints

Edit Mode:

()Move Along Slope (%) Mave Freely

Mowe [ Edit Poink

Pos. | 5621 & wal, | 16343 &

Controls for replacing a selection
with special functions

You can also replace a selection
with a number of values or spe-
cial functions (line, gamma,
inversion, etc.) by clicking
Apply.

For details see:

e (Chapter LUT editor: How to
select data on page 97

e (Chapter LUT editor: How to
extend a selection of data
on page 98

e (hapter LUT editor: How to
modify the graph between
two grip points on page 100

Selection

Replace selection with
b Apply

0.450 &

Gamma

Gamma fackor

Table 34: LUT editor: window elements

AVT SmartView for FirePackage V2.3.1
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Window element

Description

/1

Examples, controls, buttons

Edit values

Click here to open the Edit LUT
values dialog and change each
value individually.

Example of dialog for
Pike F-210C

M Fdit LUT values

X]

4 0-999

4 1000 - 1999

4 2000 - 2999

£ 3000 - 3999

£ 4000 - 4399

£ 5000 - 5999

£ 6000 - 6999

£ 7000 - 7999

£ G000 - 5999

£ 2000 - 9999

+ 10000 - 10959
+ 11000 - 115959
£ 12000 - 12559
+ 13000 - 1359599
+ 14000 - 14559
+ 15000 - 15559
+ 16000 - 163583

[ Ok ] [ Cancel l

Init

Click Init to start with two grip
points connected with a linear
graph. The two initial grip points
are (0,0) and (max, max).

e |eft starting grip point is
set to null by default.

e Right starting grip point is
set to the maximum LUT
value by default.

® The two starting grip points
are connected by a straight
line (linear) from null to the
maximum LUT value.

Example of init function with
Pike F-032C:

16384

Init grip points

8192

4

I
8192 16384 o

Table 34: LUT editor: window elements

AVT SmartView for FirePackage V2.3.1
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Window element Description Examples, controls, buttons
and e (lick Undo to let the |Use Undo and || Redo
Undo and Redo button last modification of the LUT buttons_to traverse tl?r_oug!1 the
data be undone. whole history of modifications
e C(lick |™/| Redo to let the |with two limitations:
Undo action be undone. e If the LUT data is modified

after undoing some actions,
these actions cannot be
redone.

e If the LUT editor is closed
and reopened, it is not pos-
sible to undo the actions
made before closing the
dialog.

Table 34: LUT editor: window elements

AVT SmartView for FirePackage V2.3.1
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Window element

Preview check box

Description

Activate check box to show a
preview image in SmartView
image window with edited LUT
applied.

/1/

Examples, controls, buttons

Make sure to stop image acquisi-
tion before opening the LUT edi-
tor.

Activate [#]preview to apply an
LUT on an existing image imme-
diately.

The word Preview on a purple
rectangle is written in the upper
left corner of SmartView window
to indicate that an LUT is being
applied on the image.

“ Pike FO32ZC fiber [C 0, N 3465154015] - AVT S

© File Camera Wiew Extras Help

EE >

Preview

@ |

Example of edited LUT:

I Pike FO32C fiber (CO, NO) - LUT Editor

16384 = s

8192

N T e T e e
8192 16384 o

i

< >

Corresponding Preview image in
SmartView window:

Table 34: LUT editor: window elements

LUT editor: How to select data

Note

®

With the introduction of the new grip point mechanism a
region selection is only possible from grip point to grip point.

To start: click Init. The first two grip points are created with
a linear graph between them.

To select a region (range of values between two adjacent grip points):

1. In the graph window click (with left mouse button) outside the line.

2. Keep left mouse button pressed and move cursor (to the right or left).

AVT SmartView for FirePackage V2.3.1
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3. Release left mouse button to end selection.

The two adjacent grip points that are next to the so-marked region are taken
for the current selection.

The current selection is displayed with grey background color. The elements
in the Selection section are now available. (For more information see Chap-
ter LUT editor: How to modify the graph between two grip points on page
100.)

To deactivate the current selection: click in grey background.

LUT editor: How to extend a selection of data
To extend a current selection:

1. Click on the vertical edge of a current selection (with grey background
color) and keep left mouse button pressed.

Mouse cursor changes to double-headed arrow.

%

Figure 18: Extend current selection with mouse cursor

2. Move the cursor to right or left until it snaps to the next grip point.

3. Release the left mouse button to fix the new selection.

Note If necessary: First add a new grip point to which the selection

can be extended.

LUT editor: New grip point mechanism

In order to simplify the handling and editing of look-up tables a new mech-
anism with grip points was implemented. The usage is described in the fol-
lowing subsections.

LUT editor: How to add a grip point
To add a grip point:
1. Right-click on the graph.

In the popup menu click Insert Grip Point.
A grip point is added directly on the graph.

AVT SmartView for FirePackage V2.3.1
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First way

Second way

First way

Second way

LUT editor: How to remove a grip point

To remove a grip point:

1. Right-click the grip point.

2. In the pop-up menu click on Remove Grip Point.

The grip point is removed.

To remove a grip point:
1. Move grip point onto another grip point.

The grip point is removed automatically.

LUT editor: How to move/edit a grip point
To move a grid point (Move Along Slope method):
1. Click on the grid point.

The mouse cursor changes to and the color of the grid point
changes from blue to orange.

2. In Grip Points section choose Move Along Slope option.

In graph window click on orange grid point and keep left mouse button
pressed.

Mouse cursor changes to o-I;I-o
3. Move the cursor (horizontally to right or left).
The grid point moves along the slope of the graph.

Note If the grid point is moved onto another grip point, it is

removed automatically.

®

4. Release the left mouse button to fix the grip point at the new position.

To move a grid point (Move Freely method):
1. Click on the grid point.

The mouse cursor changes to j:I and the color of the grid point
changes from blue to orange.

2. In Grip Points section choose Move Freely option.

3. In graph window click on an existing grip point and keep left mouse
button pressed.

Mouse cursor changes to o-|;|-o
4. Move the cursor right/left or up/down.

The grip point moves in the same direction as the mouse cursor.

AVT SmartView for FirePackage V2.3.1
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Note When moving a grip point, the graph lines connected to the

moving point are set back to linear function.

5. Release the left mouse button to fix the new position of grip point.

LUT editor: How to modify the graph between two grip
points

To select and modify LUT data:

1. Select data as described in Chapter LUT editor: How to select data on
page 97 and Chapter LUT editor: How to extend a selection of data on
page 98.

2. If the selection of data is done, proceed in the following way to modify
the LUT data.

3. In the Selection area use the Replace selection with combo box:

Choosing Modify method... ... does the following Replace

Value ... replaces the selection with a fixed value.

Enter this value in the Value field or use % .

Minimum value or Maximum value ... changes the selection to either 0 or the maxi-
mum value supported by the camera.
Left value or Right value ... sets the selection to the first or last selected
value. All actions
Average value ... replaces the selection by its average value. alr_e Eone by
clickin
Line ... replaces the selection by a straight line from Abpl g
: PPl
the first to the last selected value. in the
Gamma ... replaces the selection by a gamma function Selection
from the first to the last selected value. section.

Enter the gamma factor in the Gamma factor field
oruse % .

Inversion ... mirrors the current selection vertically.

The baseline for the mirroring is the first selected
value.

Table 35: Modify methods

4. Click Apply.

The chosen modify method is applied to the selection in LUT editor window.
If Preview check box is activated the chosen method is also applied on-the-
fly to the image in SmartView window.

AVT SmartView for FirePackage V2.3.1
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Working with trigger

Conditions
® During HDR mode level mode trigger (Trigger_Mode_1) is not possible.

® The multi-shot counter also controls the number of shots in
Trigger_Mode_15.

Where to find

SmartView: Main window:

£ Edit settings > Trig/I0 tab

Pike F210C [C O, N 191647362] - A¥T Smart¥iew 1.8

Ctelz |l s | THOIIO |[LUTiShdg, | adv 1 | adv 2 || adv 3

Trigaer Mulkishiok counter

Mode |Internal V| Paolarity: nok avalabl

Trigger delay Integration enable delay

Input/Cutput pins

Format || Ckrl 1

Conﬁgure Fin Mode Irvert Skate
B Input 1 Trigger Mo Loy
trigger and Input 2 Off Mo Low
. Cukput 1 IntegrationEnable Mo Lo
lnPUt/OUtPUt Qukput 2 Follow Inp Mo Lo
Oukpuk 3 Busy Mo Loy
Qukput 4 Qff Mo Lo
[]Pall the 1j0 state continually )

[#] Don't aute hide IEI EI IEI IEI

Figure 19: Trigger and Input/Output: Example (Pike F-210C)

AVT SmartView for FirePackage V2.3.1
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Trigger mode

Description

/1

ALl AVT cameras support IIDC conforming Trigger_Mode_0 and
Trigger_Mode_1 and special Trigger_Mode_15 (bulk trigger).

Stingray/Guppy PRO cameras support software triggers (AVT-own feature)
additionally: marked with -SW.

...also known as

Description

Internal

Continuous mode

The camera runs with an internally generated
trigger.

The camera sets the shutter time according to the
value set in the shutter (or extended shutter)
register.

Edge mode(0)-Ext
Edge mode(0)-SW

Edge mode
Trigger_Mode_0

The camera triggers one image precisely (aka
asynchronously) with a voltage edge received via
trigger pin of the I/0 connector.

The camera sets the shutter time according to the
value set in the shutter (or extended shutter)
register.

Level mode(1)-Ext
Level mode(1)-SW

Level mode

Trigger_Mode_1

The camera triggers one image precisely (aka
asynchronously) with a voltage edge received via
trigger pin of the I/0 connector.

The camera sets the shutter time according to the
active low time of the pulse applied (or active
high time in the case of an inverting input).

The trigger signal thus serves dual purposes:

e First to set the trigger moment and

e secondly to instruct the camera how long to
shutter (integrate).

Use this mode for overriding the 67 seconds long

time integration limit or if you need to adapt to

brightness changes but without using the shutter

register and software calls.

Progr. mode(15)-Ext
Progr. mode(15)-SW

Programmable mode

Trigger_Mode_15

Is a bulk trigger, combining one external trigger
event with continuous or one-shot or multi-shot
internal trigger.

Table 36: Description of trigger modes

AVT SmartView for FirePackage V2.3.1
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Perform steps

Configuring trigger modes

To configure the trigger modes do the following:

1.

In Trigger section choose your desired mode (Internal, Edge mode(0),
Level mode(1), Progr. mode(15)).

For Edge mode(0) or Progr. mode(15) choose the Polarity of the trigger
signal (Falling or Rising). For level mode(1) choose the Polarity of the
trigger signal (Low act. or High act.).

In Multishot counter section set the number of images for the camera to
take in succession.

If you choose Edge mode(0): In Trigger delay section you can set a trig-
ger delay (activate On check box) and a delay time in ps for the trigger
signal to become effective.

In Integration enable delay section you can switch on/off (On check
box) the delay of the integration enable event. Enter the delay time in
us. Use this e.g. if you fire a flash with IntEna and want to delay when
the flash is fired relative to the trigger.

In SW trigger section you can set a software trigger (click Trigger).

AVT SmartView for FirePackage V2.3.1
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Scenarios for trigger modes

/1

The following scenarios show some examples when the three trigger modes
are useful.

Typical scenario

Additional information

Trigger_Mode_0

Moving objects to be triggered
precisely at the same position.

Motion blur (the amount of
movement during the shutter is
open) may also affect the image
quality. Thus a controlled and
bright illumination (or flash
driven by IntEna signal of cam-
era) with a proper and short
shutter time may be required.

Trigger_Mode_1

® Moving objects to be trig-
gered precisely at the same
position.

® Brightness changes to be
controlled via the trigger
signal itself.

This mode emulates the behavior
of popular analog cameras.

Trigger_Mode_15

e Grabbing exactly one image
based on the first external
trigger.

® Filling the camera's internal
image buffer with one exter-
nal trigger without overrid-
ing images. (By setting
Multi_shot counter =
#frames fitting in internal
memory)

e Grabbing an unlimited
amount of images after one
external trigger
(surveillance)

The Technical Manuals of the
cameras have in depth examples
how to set up these three exam-
ples.

Perform steps

Configuring input/output pins

Table 37: Typical scenarios for trigger modes

Each input pin and each output pin can be configured individually to your
needs for example the above mentioned triggering of the cameras.

To configure the input/output pins do the following:

1. In Input/Output pins section choose for every input and output pin the
desired mode. To change a mode, click on the mode field. A combo box
opens: click on the desired mode.

For each pin you can choose one of the following modes:

AVT SmartView for FirePackage V2.3.1
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Input = (Off/Trigger)
Output =
(Off/Direct/IntegrationEnable/FrameValid/Busy/FollowInp)

2. Choose the Polarity bit in the Invert column. To change an Invert entry,
click on the invert field. A combo box opens: click on No or Yes to
change the Polarity bit.

Note The former Polarity column for the input/output pins is now
called Invert to clarify the use of this bit. A polarity of low
in former SmartView versions is now read as Invert:No,
meaning the same.

If you set more than one input for trigger, all inputs are log-
ically ANDed.

The State column lists the status of the input/output pin (Low or
High).

3. Activate [¥] Poll the I/0 state continually to update the state of pins
every 200 ms.

AVT SmartView for FirePackage V2.3.1
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Using logging functionality of SmartView
(*.cmd file)

Conditions

e Appropriate start option must be supplied.
® Log file is created in folder of viewer executable.

Where to find

Has to be done manually. See Description.

Description

SmartView provides a logging facility for errors that might have occurred dur-
ing the operation of the program. This is helpful if you want to debug prob-
lems in cooperation of the software with the cameras and the associated
hardware in question.

e The logging file is created only if an appropriate start option is sup-
plied.

® The log file is created in the same folder as the viewer executable.

There are two options for the log file:

e Ttis only flushed every 8000 characters or after closing SmartView.

e Tt is auto-flushed when needed.

Setting via Extras = Auto-flush logging file (May slow down system). See
Submenue Auto-flush logging file on page 35.

The following log levels are listed in decreasing severity and include all the
log levels above them:

e "d": debug

e "-e": error

e "-w": warning

e """ info

AVT SmartView for FirePackage V2.3.1
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There are two ways to use the logging functionality:

First way Place a link to SmartView on the desktop and modify the properties of the
link accordingly.

AVT SmartView 1.8 Properties j|z|

General | Shortcut | Compatibilty |

E‘?f AVT SmartView 1.8

Target type: Application

Target location: SmartView

Target: |ackage\Smart‘-ﬁew‘uﬁ.‘u’T_Smart‘nﬁew_1_B.exe" ! |

Start in: | |

Shortcut key: | Maone |

Bun: | Momal window b |

Comment: | Fullfeatured viewer application for AVT cameras |

[ Find Target... J [ Change lcon... J [ Advanced... J

| ok || cance || Apply |

Figure 20: Properties dialog of SmartView

Second way Alternatively create a *.cmd file with the options
(e.g. SmartView.exe -i) in the SmartView directory.

2 smartview.cmd - Editor |:||E||X|

Datei Eearbeiten Format  Ansicht ¢

start AvT_smartview_1_8.exe -1

Figure 21: SmartView.cmd file

AVT SmartView for FirePackage V2.3.1
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Channel balance (only Pike)

Conditions

e ALl KODAK Pike sensors: channel balance
(color cameras: Format_7 mode and RAW mode/no debayering)
(b/w cameras: Format_7 mode and Mono mode)

Where to find

Channel balance: Extras - Adjust channels

" Pike FO32C [C 0, N O] - AVT SmartView 1.12 AFE channel adjustment El

©File  Camera  Wiew | | Help

Ll e By Setasyncspeed Gain adjustment

v Allow async block transfer

L

v Drop fFaulty frames

-2043 2047

[]Gain auto adjustment

Adjust channels ... Alk+Cirl4+-A Program
Show SIS data...

Sequence dialog ... Al+CEr+S Offset ad_]ustment —

B
-255 255

Offset adjustment

First step: for adjusting the offset balance,
dose the lens and set the gain slider to neutral
position. Second step: for adjusting the gain
balance, please select an image with an
equalized vertical intensity distribution (all
intensity values should be present)

Figure 22: Channel balance: Example (Pike F-032C)

Description

Pike channel balance

Technical
background To achieve more speed, the Kodak sensors of the Pikes are read out horizon-
tally via two separate channels, so two ADCs are involved which may have to
be configured differently. A standard adjustment between the channels is
done at production time, but under certain circumstances, an intensity step
might still be visible from left to right.

Perform steps To be able to make the step disappear, there is an extra dialog available from
the viewer window.

AVT SmartView for FirePackage V2.3.1
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To carry out an adjustment (offset adjustment + gain adjustment) in
SmartView, perform the following steps:

1. In SmartView click Extras > Adjust channels... or use Alt+Ctrl+A.

The following window opens:

AFE channel adjustment

Gain adjustment

-2043 2047

[]Gain auto adjustment

Offset adjustment
=

B
-255 255

Offset adjustment

| -
=]
o
s}
ol
()

First step: for adjusting the offset balance,
dose the lens and set the gain slider to neutral
position. Second step: for adjusting the gain
balance, please select an image with an
equalized vertical intensity distribution (all
intensity values should be present)

2. Put on lens cap.

3. Set gain adjustment slider and offset adjustment slider to 0.

4. Click several times Offset adjustment until the slider does not move
any more.

5. Put off lens cap.

6. Take test sheet with vertical continuous b/w gradient, defocus lens and

start image acquisition.
7. Activate Gain auto adjustment.
Now left and right channel should be adjusted for all grey values, so

that vertical line is no more visible.

Note Channel adjustment should be done in the same gain region
as in your real application. If you use a much greater gain in

@ your application, it may be necessary to do the dual-tap off-
set adjustment again.

Dual-tap offset adjustment is done once in the AVT factory
and saved via Program button in User set 0.

The Program button is not available for the user.

AVT SmartView for FirePackage V2.3.1
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Note For more information read Pike Technical Manual, Chapter

Channel balance.

AVT SmartView for FirePackage V2.3.1

110



Operating AVT cameras with SmartView / / /

Using HDR mode (CMOS cameras)

Conditions

e  Guppy F-036: HDR mode of Micron MV022 sensor

e Marlin F-131: HDR mode of FillFactory IBIS5B sensor

® For HDR mode: number of knee points must be greater 0.

Where to find
HDR: || Edit settings > CMOS tab, Section High dynamic range mode

Configure Guppy FO36B [C 1, N 198591586] - AVT Smartview 1.8 5]
HDR Format | kel 1| Chel 2 | Trig/IC || LUTShdyg. | Adv 1 | Ady 2 | CMOS

igh dynamic range mode
HOR. mode an Yolkage #1 knee points | 1 E
s 3 | |

Figure 23: HDR mode: Example (Guppy F-036B)

Description

Guppy F-036: Micron MV022 HDR mode

Technical
background The HDR mode of the Micron MV022 sensor allows for two knee points. They
are controllable in an easy mode, which means that the draining voltage may
be set for both knee points (measured from the minimum voltage) and the
time is assigned automatically by the sensor.

Perform steps On CMOS tab:
1. Enter voltage levels from 0 to 31.

A value of 0 means 0.5625 Volt (each step meaning an increase of
0.0625 Volt).

2. If you select two knee points, the second value must be less than or
equal to the first value.

AVT SmartView for FirePackage V2.3.1
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Note For more information read:

e Chapter CMOS tab descriptions on page 58, Section High
@ dynamic range mode (only Guppy F-036)

* Guppy Technical Manual, Chapter HDR (high dynamic

range) (Guppy F-036 only) [approx. 5 pages]

Marlin F-131: IBIS5B HDR mode

The HDR mode of the IBIS5B sensor allows for three knee points. This
enables the high dynamic range of the sensor to be compressed into 8 bit,
preserving interesting details of the image. This mode is also known as mul-
tiple slope (dual slope).

Marlin F131B [C 1, N 199705698] - A¥T Smart¥iew 1.8 5]

DSMUElemish pixel correction
|:| DSMNU correction on

[ 5how correction daka image

Correction data using| 1 imagefs)

[ Save data to flash ] [Load data from Flash] [Delete correction data]

[C1Elemish correction on

Don'tluto hide El El @ l:l

l

Configure
HDR

Marl;

High dynamic range mode Grey level ] 2.0x 15:1dB)
HDR mode on Knee paints n Di S p lay g
® Eass‘u:'| mode P 519
0.0dE 73.4dE
o e ] || graph
() Expert mode _>
Shutter time Tatal Time:
[394s || | [ || REEE
\ 143

in F131B {C0, N1) - HDR Graph

2 knee points

Light intensity

Figure 24: HDR mode of Marlin F-131B (2 knee points + Easy mode + Display graph)

Perform steps On CMOS tab:

1. Change number of knee points to value greater 0 (Example: 2).
2. Activate HDR mode on check box.

3. In Easy mode put slider in the desired position (the knee point values
will be set automatically.
In Expert mode enter values for Add.time #1 (#2, #3) manually.

4. Activate Display graph check box to display the HDR Graph window.

AVT SmartView for FirePackage V2.3.1
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Note For more information read:

e Chapter CMOS tab descriptions on page 58, Section High
@ dynamic range mode (only Marlin F-131)

e Marlin Technical Manual, Chapter IBIS5A multiple

slope (High Dynamic Range mode).

AVT SmartView for FirePackage V2.3.1
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Error Messages and FirePackage Error Flags

We analyze and discuss the data flow from an AVT camera (e.g Marlin) to the
main memory of a PC under Windows™ using AVT FirePackage assuming a
FireGrab or FireStack based implementation like e.g. SmartView. First we
notice a frame buffer in the camera, which can hold usually more than one
image in the camera. The frame memory is constructed as a FIFO (first in first
out) memory. Frame buffer(s) in a camera are beneficial for the sensor han-
dling as well as for additional features (such as deferred image transfer). A
frame bufferin the camera is not primarily intended or needed for secure data
flow aspects.

EeEmman ;
S Gores | Ofse . LT
mEm §?P|5|Cff:::: Analog Analog y 10Bit|  Correction 10 Bit
e - —
TITTTTTT . 1
Camera Control -
z 5 L 5 L
:
5 IEEE-1394 ——— Frame- —
139421 Interface 8Bt | —Memory—

Figure 25: Block diagram Marlin b/w camera

The frame memory is followed by a much smaller FIFO buffer (size of 4 kByte)
in the 1394 interface (link chip) to buffer the data prepared to send of about
one 1394 cycle.

Data then is sent via a DMA mechanism to the corresponding 1394 receive
buffer in the PC, which has also usually the size of 4 kByte.

Speed of the PCI (express) bus is high enough and latency of it is usually very
low so that no overflow or underflow of Receive-FIFO is occurring.

AVT SmartView for FirePackage V2.3.1
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A block diagram of the incoming receive OHCI chip (by TI) interface shows
the details:

Serial
TPC' Internal Bl ROM L
ar] O L] Registers DHCI PCT Pawer
A Mymi & CLERUN GPIOs
u u | 180 Transmit = s MISC
Aal Contexts = Ly Interface
2 & | Async Transmit = Transmit
i Contexts e FIFO
b
u n | Physical DMA & Link
T & Reaponae = Tiamsanit
[y |
> Resp -
2 Timeout Receive o >
- Acknowledge v
1
Host I
Bus Caniral PHY .
Interface Arbiter Rugister Cycle Starl -
&
e Accass Gemrain( & TRC
& Status Cycle Monitor
Im::‘tm Monitor =
o PHY |
. Link
Reguest Synthesized Interface
Fillers el Fadsl
I
— General Z Link |
W) Request Receive [ Receive [
g o | Async Response | o Receive
e Receive - FIFQ -
+#
s 150 Receive |
—pe Contexts d

Figure 3-1. TSB12LV26 Block Diagram

Figure 26: Block diagram of incoming receive OHCI chip (by TI)

If an error occurs, the Receive FIFO is most probably the critical section.

Other devices of the PC, such as network adapter or USB or peripheral devices
may also occupy the PCI bus so that the performance for the 1394 part can
be negatively influenced or becomes too low.

Debugging this situation requires the temporal deactivation of these periph-
eral devices accompanied by lowering the packet payload of the 1394 device.

With the use of MS low level device driver for 1394 ports, errors in the low
level data flow which are created by the hardware such as Receive-FIFO over-
flows are not reported to the application.

FirePackage on the other hand replaces the MS device driver by a specific
(monolithic) driver for the 1394 device class which fully reports errors to the
application. The following is a list of the various error messages, generated
by the driver and the associated dlls.

AVT SmartView for FirePackage V2.3.1
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Note While it is not the purpose of this document to explain each
and every theoretically possible error, it might be helpful in

the event of debugging to communicate the exact error mes-
sages to the support staff.
Error codes returned by functions

Every function returns a 32-bit error code that contains additional informa-
tion about the error.

The module differs between upper layer error codes (that start with FCE_xxx)
and low level error codes that start with (HALER_xxx).

The following two tables show the coding and describes each error.

HALER xxx codes

Error name Number Error description

HALER_NOERROR 0 No error.

HALER_NOCARD 1 No hardware found.

HALER_NONTDEVICE 2 No logical device could be created for the card (memory
problem).

HALER_NOMEM 3 Not enough memory for this operation.

HALER_MODE 4 Wrong mode for this operation.

HALER_TIMEQUT 5 Time-out occurred.

HALER_ALREADYSTARTED 6 Device was already started and cannot be started twice.

HALER_NOTSTARTED 7 Device was not started.

HALER_BUSY 8 Device is busy at present.

HALER_NORESOURCES 9 Not enough resources (no more interrupts, no threads
etc.).

HALER_NODATA 10 There is no data to acquire.

HALER_NOACK 11 No acknowledge received from the target.

HALER_NOIRQ 12 Expected an interrupt but there was none.

HALER_NOBUSRESET 13 Expected a firewire bus reset but there was none.

HALER_NOLICENSE 14 No license to perform this action.

HALER_RCODEOTHER 15 Response code of target for actual requested subaction
other then RCODE_COMPLETE (response code is also
returned).

HALER_PENDING 16 Something has been started and is in a pending state.

Table 38: HALER_xxx codes
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Error name Number Error description

HALER_INPARMS 17 Error in input parameter (mostly range error).

HALER_CHIPVERSION 18 Wrong chip version for this function.

HALER_HARDWARE 19 Hardware error.

HALER_NOTIMPLEMENTED 20 Function is not implemented.

HALER_CANCELLED 21 A waiting function was cancelled by another user call.

HALER_NOTLOCKED 22 A device is unlocked and needs to be locked for this
action.

HALER_GENERATIONCNT 23 A function for asynchronous communication was called

after a bus reset without having called <FCTLGetBus-
Info> in order to get the new addresses of all existing

nodes.
HALER_NOISOMANAGER 24 Function requires an isochronous resource manager but
there is none.
HALER_NOBUSMANAGER 25 Function requires a bus manager but there is none.
HALER_UNEXPECTED 26 Internal processing error, unexpected value detected.
HALER_REMOVED 27 Target for command was removed.
HALER_NOBUSRESOURCES 28 Either no isochronous channel or isochronous bandwidth
available.
HALER_DMAHALTED 29 An isochronous receive DMA has been halted.

Table 38: HALER_xxx codes

FCE_xxx codes

Error name Number Error description

FCE_NOERROR 0 No error

FCE_ALREADYOPENED 1001 Device is already open and cannot be opened twice.

FCE_NOTOPENED 1002 Device must be opened before.

FCE_NODETAILS 1003 No details for this error

FCE_DRVNOTINSTALLED 1004 Kernel mode driver not installed.

FCE_MISSINGBUFFERS 1005 Not enough buffers for the requested isochronous com-
munication.

FCE_INPARMS 1006 Error in input parameters (mostly range error).

FCE_CREATEDEVICE 1007 Error creating a logical device to connect to the kernel
mode driver.

FCE_WINERROR 1008 Internal windows error.

FCE_IOCTL 1009 Error while calling kernel mode driver.

Table 39: FCE_xxx codes
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Error name Number Error description

FCE_DRVRETURNLENGTH 1010 Data returned from kernel mode driver has wrong length
(version problem).

FCE_INVALIDHANDLE 1011 Handle has invalid value.

FCE_NOTIMPLEMENTED 1012 Function is not implemented.

FCE_DRVRUNNING 1013 Kernel mode driver runs already.

FCE_STARTERROR 1014 Kernel mode driver could not be started.

FCE_INSTALLERROR 1015 Kernel mode driver could not be installed.

FCE_DRVVERSION 1016 Wrong version of kernel mode driver.

FCE_NODEADDRESS 1017 Error in node address specified.

FCE_PARTIAL 1018 User supplied buffer was only filled partially (buffer was
too small).

FCE_NOMEM 1019 Not enough memory for this request.

FCE_NOTAVAILABLE 1020 The requested function is not available.

FCE_NOTCONNECTED 1021 The object is not connected to a real target.

FCE_ADJUSTED 1022 One of the parameters had to be adjusted.

Error name
HALERF_RXHLTISOO

Table 39: FCE_xxx codes

Error flags in global error field

Error codes are returned when a function is called. Error flags are something
different. During processing in the background there is a potential risk that
an error occurs. This error can not be assigned to any function. So these is
handled by the error flags. One or more error flags are set when an error
occurs and are stored within a 32-bit field.

When an application wants to be notified this bit field is posted to the appli-
cation with an WPARAM_ERROR message. In the 32-bit field each bit has a
specific meaning. The following table shows the bit values and explains their
meaning.

HALERF_xxx

Value
0x00000001 |Isochronous RXDMAO had to be stopped.

Error description

HALERF_RXHLTISO1

0x00000002 | Isochronous RXDMA1 had to be stopped.

HALERF_RXHLTISO2

0x00000004 |Isochronous RXDMA2 had to be stopped.

HALERF_RXHLTISO3

0x00000008 | Isochronous RXDMA3 had to be stopped.

HALERF_RXHLTISO4

0x00000010 |Isochronous RXDMA4 had to be stopped.

HALERF_RXHLTISO5

0x00000020 |Isochronous RXDMA5 had to be stopped.

Table 40: HALERF_xxx
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Error name Value Error description

HALERF_RXHLTISO6 0x00000040 |Isochronous RXDMAG6 had to be stopped.

HALERF_RXHLTISO7 0x00000080 |Isochronous RXDMA7 had to be stopped.

HALERF_ISORXACK 0x00000100 |Isochronous DMA reported error in packet ACK

HALERF_ISORX 0x00004000 | Unspecified isochronous receive error.

HALERF_TXRESPONSE 0x00008000 |Could not send a response for a request (Read or Write).

HALERF_ASYRX 0x00010000 | Error during asynchronous reception.

HALERF_ASYTX 0x00020000 | Error during asynchronous transmission.

HALERF_PHYTIMEOUT 0x00040000 | The Phy took to long to transfer an information to the
Linklayer chip.

HALERF_HDRERROR 0x00080000 | A packet with an unknown header was received.

HALERF_TCERROR 0x00100000 |Packet with unknown TCode was received.

HALERF_ATSTUCK 0x00200000 | Asynchronous transmit FIFO stucked.

HALERF_GRFOVERFLOW 0x00400000 | General receive FIFO overflowed (access to PCI bus too
slow)

HALERF_ITFUNDERFLOW 0x00800000 |Isochronous transmit FIFO underflow (access from PCI
bus too slow)

HALERF_ATFUNDERFLOW 0x01000000 |Asynchronous transmit FIFO underflow (access from PCI
bus too slow)

HALERF_PCIERROR 0x02000000 | Error while accessing PCI bus.

HALERF_ASYRXRESTART 0x04000000 | Error in asynchronous transmit state machine. Transmis-
sion had to be restarted.

HALERF_NOACCESSINFO 0x08000000 |No access info could be allocated while an external
access occurred.

HALERF_SELFID 0x10000000 | Error while receiving SelfIds.

HALERF_DMPORT 0x20000000 | Error in data mover port (GP-Lynx only)

HALERF_ISOTX 0x40000000 | Error in isochronous transmission.

Table 40: HALERF_xxx
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Setting AOI (Format_7 settings)

Definition

Configure
AOI

AOI = area of interest

Area of interest readout (AOI) refers to a camera function whereby only a
portion of the available pixels are read out from the camera. For example, it
is possible to read out a 640 x 480 pixel area of pixels from a camera that
has a total resolution of 1628 x 1236. The result is a much faster frame rate
and less data to be processed. This is also referred to as partial scan. Various
autofunctions (auto shutter, auto gain, auto white balance) act on the AOL.

Conditions

e (Camera has to be in Format_7 mode

Where to find

SmartView:

| Edit settings > Format tab (Section Format7 settings)

Pike FZ10C [C 0, N 191647362] - AYT SmartYiew 1.8
Format |cirl 1 | Crl2 |l 3 | Trig/1o | LUTjShdg. | Adv 1 | adv 2 | adv 3|

Fixed & wariable modes. ..

Formak Colar Framerabe 150 speed Debayering
320x240 Monog --imvalid -- | (5100 nane w
640450 Ylv411 5200

S00xa00 Y422 2400 &uto. patterr
1024x768 RGES

1280960 P8 De-Interlace
F7 mode 0 R 16 )

Frmoded | |RAWIZ FIE D ST el

F7 mode 5 150 channel

F7 mode &
Auto Chn,  Frame buffers
o vt ?]
Format? setkings. .. (max, 1920 x 1080)
Left (£ 2 pe) wWidth (£ 4 pec) Top (£ 2 pe) Height (£ 2 px)
o S S E s 40 3
e Packet size 2152 Auka size Maz Frame rate
| 2152 | | =575 ks
J'

[#] Don't aute hide IEI EI IEI IEI

Figure 27: Setting AOI (Format_7 settings): Example Pike F-210C
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Description

The image sensor on the camera has a defined resolution. This indicates the
maximum number of lines and pixels per line that the recorded image may
have.

However, often only a certain section of the entire image is of interest. The
amount of data to be transferred can be decreased by limiting the image to
a section when reading it out from the camera. At a lower vertical resolution
the sensor can be read out faster and thus the frame rate is increased.

Note The setting of AOIs is supported only in video Format_7.

®

While the size of the image read out for most other video formats and modes
is fixed by the IIDC specification, thereby determining the highest possible
frame rate, in Format_7 mode the user can set the upper left corner and
width and height of the section (AOI=area of interest) he or she is inter-
ested in to determine the size and thus the highest possible frame rate.

SmartView offers a convenient procedure for the selection of an AOI in the
Format tab.

After selecting a Format_7 mode the selection is available. You can choose a
subwindow and its position according to your needs. IIDC specifies for
Format_7 that the transferred packet size has to be adjustable. This is
reflected in the packet size slider which allows to limit the packet size (the
amount of image data, which is transmitted from the camera every 125
microseconds). Lowering this packet size leads to a lower max. frame rate as
displayed in the box.
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Figure 28: Area of interest (AOI)

In addition to the area of interest, some other parameters have an effect on
the maximum frame rate:

e Time for reading the image from the sensor and transporting it into the
FRAME_BUFFER

* Time for transferring the image over the FireWire™ bus
e Length of the exposure time

AVT SmartView for FirePackage V2.3.1
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Calculating frames per second

Conditions
® Acquiring images (one-shot, multi-shot, continuous)

Where to find
View > Status bar

The current frame rate is displayed in the status bar.

123 £40x450

Figure 29: Status bar: display of frame rate

Description

AVT implemented a new frame rate calculation. The following chapter
explains the difference between theoretical and displayed frame rate.

New Frame rate calculation

In order to transfer the possible frame rate there is a new way to calculate
the MaxBPP.

The maximum number of packets to be transferred with MaxFPS is deter-
mined. From this MaxBPP is calculated.

It is possible, that one cycle is dropped between two images. Nevertheless
the frame rate formula can be used (Technical Manual, Chapter Frame rates
Format_7). MaxFPS of sensor will be reached.

Example: calculation of frame rate (SmartView vs. Camera)
Calculation of MaxPPF: PPF = 1 / (MaxFPS x 125pus) = 38.29

Round off = PPF = 38

Calculation MaxBPP: MaxBPP = 640 x 480 / 38 = 8084.21

This value will be rounded up to N-quadlets: MaxBPP = 8088

AVT SmartView for FirePackage V2.3.1
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Caution SmartView calculates frame rate always according to the for-
mula:

/ frame rate = 1 / ((PPF + 0.5) x 125ps)
Therefore SmartView will show a frame rate of
frame rate = 207.79 fps

whereas the camera reaches a frame rate of approx. ~208.5

Note If you choose other BPP than MaxBPP, then the calculated
frame rate is the same as the former calculating method. So
@ both calculating methods are compatible.
Pike F-032B, 640 x 480, Mono8, MaxFPSccd=208.93

Status bar counters

Usually there is one counter to be seen at the bottom right hand side in the
status bar of the viewing window which counts all frames sent from camera.
Under practical circumstances it can happen that SmartView could not pro-
cess and display all images from the camera or that even the driver could not
reassemble all images from the camera.

Conditions

This usually indicates problems in the hardware or the software such as
® Problems with the cabling (transmission errors)

® Bandwidth over the 1394 bus(es) exceeded

e PCI (Express) bus bandwidth exceeded

e PCI latency problems

e Problems with power consumption reduction options like Intel Speed
Stepping or AMD PowerNow or Cool'nQuiet, resulting in overflows of
receiving FIFO

e (PU resources problems

Where to find
View = Status Bar

Description

If there are three numbers displayed, not all frames arriving on the card could
be processed and displayed.

e The first (left) number now shows the number of frames arrived at the
card. (5077 in figure below)

AVT SmartView for FirePackage V2.3.1
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e The second number shows the number of frames lost on driver level
(e.g. due to receive FIFO overflows) (0 in figure below)

¢ The third number shows the number of frames lost due to poor process-
ing capability. (37 in figure below).

The frame rates shown still show the frame rate at the card and, if there is a

second frame rate, the right one shows the processed frame rate.

12.2/12.1 1392x1032

Frames lost due to poor processor capability

Frames lost on driver level

Total transferred frames

Figure 30: SmartView counters

Note The screenshot shows one example which was produced in a
multi-camera environment leaving the Bayer demosaicing
to the PC and forcing it to the most challenging algorithms.
As a consequence SmartView was not able on this PC to keep

up with all the frames from the cameras.

AVT SmartView for FirePackage V2.3.1
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Format_7 mode mapping (only Stingray/Pike/
Guppy PRO F-503)

In Stingray/Pike/Guppy PRO (F-503) cameras, you can customize your
Format_7 layout with respect to binning (only b/w) or sub-sampling (b/w
and color) via the so-called Format_7 mapping.

Format_7 Mode_0 is factory setting (full resolution) and cannot be changed.

Note For a detailed description of mapping to Format_7 Mode_1 ...

Mode_7 see Stingray/Pike/Guppy PRO Technical Manual,
@ Chapter Binning and sub-sampling access.
Conditions

e Binning: Stingray/Pike/Guppy PRO F-503 b/w camera
e Sub-sampling: Stingray/Pike/Guppy PRO F-503 b/w or color camera

Where to find

SmartView entry window: Menu Camera - Format 7 mapping...

5 AVT SmartView 1.8

== Yiew  Help

OpenfClose view  Chkrl+0, Enter

Initialize the camera

Soft reset
Llidate Firmware,

Settings... Alt+E
Exit Alk+

Zonfigure Format 7 For binning)subsampling

Figure 31: Format_7 mode mapping

AVT SmartView for FirePackage V2.3.1
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Description

To map one or more modes to F7M1 ... F7M7 do the following:

1. In SmartView entry window click on Camera - Format 7 mapping...
The following window opens:

Format 7 Mode Mapping [
Format 7 Mode Configuration: Zonfiguration For Mode: O
0: [Full resolution Decimation Type:
1: &H, &¥ hinning binmi
Z: 2/18H, 2/16Y subsampling inning
3t [default] Horizonkal Decimation:
4 [default] )
5: [default] Full resolution
B [default] Wertical Decimation:
7 [default] )
Full resolution
[ Zamera Mode Info ... ] [ apply ] [ Zancel

Figure 32: Format_7 mode mapping window

2. Choose your mappings and click on Apply.

Note Examples for abbreviations:
H means horizontal; V means vertical

@ 2H binning means 2 x horizontal binning
2/4 H sub-sampling means 2 out of 4 horizontal sub-sam-
pling

F7M1 means Format_7 Mode_ 1

AVT SmartView for FirePackage V2.3.1
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H  2H

Decimation Type

/1

Description

Disabled

Chosen mode disappears from the
Format_7 mode list.

Default

Factory settings are used:
Pike cameras:

F7M1:
F7M2:
F7M3:
F7M4:
F7M5: 2/4 V sub-sampling

F7M6: 2/4 H, 2/4 \ sub-sampling

2H binning

2V binning

2H, 2V binning

2/4 H sub-sampling

Binning

Choose binning factors from combo
boxes below.

full resolution

o 2
* 4
e 8

Sub-sampling

Choose sub-sampling factor from
combo boxes below.

full resolution
o 2/4

2/8

2/16

Table 41: Decimation types

For an overview of the available modes, click on Camera mode info.

For Pike cameras the following window opens:

Format 7 Mode Info (] Format 7 Mode Info (]
Subsampling Modes Einning Modes Subsampling Modes
4H  8H 2i2H | 2/4H | 2Zi8H | 2/16H OH 24 | 4H | &H 2i2H | 2/4H | 2Zi8H | 2/16H
A kS iy w # A # oy - - iy w # A #
A kS 2i4y ¥ # A # 2 2i4y ¥ # A #
A kS 2lav ¥ # A # 4y 2lav ¥ # A #
A kS 2f1ey ¥ # A # av 2f1ey ¥ # A #

0 2l
* "
2 R "
* "
* "

Clase

Clase

Figure 33: Camera mode info window (left: b/w; right: color Pike cameras)

AVT SmartView for FirePackage V2.3.1
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When saving settings to an XML file, a hash value is calculated and stored for
each Format_7 mode, so that it is not possible to read illegal settings for a
re-mapped mode. This has of course no impact on old settings files. In this
case, illegal settings could be re-read.

AVT SmartView for FirePackage V2.3.1
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Packed 12-Bit Modes
(only Stingray/Pike/Guppy PRO)

For Stingray/Pike/Guppy PRO cameras special Packed 12-Bit modes are
available.

Conditions

e Stingray/Pike/Guppy PRO b/w camera: MONO12 (color ID 132)
Stingray/Pike/Guppy PRO color camera: RAW12 (color ID 136)

Where to find

SmartView: ¢ Edit settings > Format tab (b/w: MONO12; color: RAW12)

Pike F210C [C O, N 191647362] - A¥T Smart¥iew 1.8

Format |cirl 1 | Crl2 |l 3 | Trig/1o | LUTjShdg. | Adv 1 | adv 2 | adv 3|

Fixed & wariable modes. ..
. Formak Colar 150 speed
Packed 12-Bit 320x240 Maonod --imwalid -- | |5100 \
M Ode 640450 Ylv411 5200
\ B00xE00 YIly4z2 5400 auto. patterr ¥
N 1024x768 RGES

60 'S De-Interlace
%F? i @ High SHR mode Ouly 2X2.
F7 mode 5 150 channel D bayermg
F7 mode &

Auto Chn,  Frame buffers

o vt ?]

Format? setkings. .. (max, 1920 x 1080)
Left (£ 2 pe) wWidth (£ 4 pec) Top (+ 2 pe) Height (£ 2 pu)
o 3 e S E s 40 3
Packet size Auka size Maz Frame rate
| | |=s.75fes |

[#] Don' aute hide IEI EI IEI I:I

Figure 34: Format tab: Packed 12-bit Mode (Pike F-210C: RAW12)

Description

The new Packed 12-Bit Modes are only available in Format_7. At RAW12
color mode there is only 2x2 debayering available. For a detailed description

see Stingray/Pike/Guppy PRO Technical Manual, Chapter Packed 12-Bit
Mode.

AVT SmartView for FirePackage V2.3.1
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Sequence mode (Stingray, Pike, Marlin)

Definition

Sequence mode is a concept where the camera holds a set of different image
parameters for a sequence of images. The parameter set is stored volatile in
the camera for each image to be recorded. This sequence of parameter sets
is simply called a sequence. The advantage is that the camera can easily syn-
chronize this parameter set with the images so that no uncertainty can occur.

Additional information

For additional information on the sequence mode feature read the following
chapters:

e Stingray Technical Manual, Chapter Sequence mode

e Pike Technical Manual, Chapter Sequence mode

e Marlin Technical Manual, Chapter Sequence mode

Conditions

e Stingray camera
e Pike camera
e Marlin camera

AVT SmartView for FirePackage V2.3.1
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Where to find

Extras - Sequence dialog...

T Pike F210C [C 0, M 191647362] - AVT SmartView 1.8

Open
Sequence editor

Set async speed L

Allove async block transfer
Drop Faulty Frames

Auko-Flush logaging File

adjust channels .., Alk+Ckr+A
Secure Image Stamp info ...

Sequence dialog ...

Sequence editor Pike F210C [C 0, N 191647362] - A¥T SmartView 1.8 &3]
File
Step RepCrt | StepMods  YFormat  ¥Mods | WFps  Isochn | IsoSpd  Brightness | WhiteBalvR | WhiteBalUB | Shutter Gan  Sharpness  HighSWR | LUT  Shading  ImgMirror | ImgPosL ImgPosT | ImgSizeW  ImgSizeH
1 0 on 7 0 5D SE00 16 254 284 200 0 0 0 Off  on Off i 0 840 450
z 0 on 7 0 EE ] S800 16 284 284 1800 0 0 0 off  on Off i 0 640 480
3 0 on 7 0 5D SE00 16 254 284 1600 0 0 0 Off  On OFF i 0 840 450
4 0 on 7 0 EER ] S800 16 284 284 1400 0 0 0 off  on Off i 0 640 480
5 0 on 7 0 5D SE00 16 254 284 1200 0 0 0 Off  On OFF i 0 640 450
[ 0 on 7 0 5o S800 16 284 284 1 0 0 0 off  on Off i 0 640 480
7 0 on 7 0 EE ] SE00 16 254 204 00 0 0 0 Off o Off i 0 640 480
E 0 on 7 0 JE o0 800 16 284 284 0 0 0 off  on off o 0 &40 430
3 i | )
Length: et currert settings futo-rewind (] Dissble Sequence | [ Apply Sequence
Sequence editor Pike F210C [C 0, N 191647362] - A¥T SmartView 1.8 53]
File
ColorlD  BytePacket | ColCorr. | CCCoeffl | CCCosffz | CCCoeff3 | CCCosff4 | CCCoeffS | CCCosffe  CCCosff? | CCCosffs CCCosffS | Outputl  Outputz  Output3 | Output4 | SIS | SIsline | SISUserdal
RAwlz 3224 on 1025 71 -96 229 1371 -142 57 -41 1354 Off Off Off Off off 0 i
RAw1z 3224 on 1025 71 -9 229 1371 -142 57 411 1354 off OFf off Off off 0 i
RAwlz 3224 on 1025 71 96 229 1371 -142 s7 -411 1354 OFF OFF OFF OfF off 0 i
RAw1z 3224 on 1025 71 -9 229 1371 -142 57 411 1354 off OFf off Off off 0 i
RAwlz 3224 on 1025 71 96 229 1371 -142 s7 -411 1354 OFF OFF OFF OfF off 0 i
RAw1Z 3224 on 1025 71 -9 229 1371 -142 57 411 1354 off OFf off Off off 0 i
RAwlz 3224 an 1025 71 -9 229 1371 -142 57 -411 1354 OFf OFf Off Off off 0 i
Rawlz 3224 on 1025 71 -9 229 1371 -142 57 411 1354 off off off Off off 0 i
a il 3
Length: et currert settings fwtorenind (] Dissbie Sequence | [Apply Sequence

Figure 35: Sequence editor: example for eight different image settings

Description

Perform steps We show you an example how to work with the sequence editor (see screen-
shots above). Our aim is to set up a sequence with eight different image set-
tings (varying shutter from 1000...300 in steps of 100).

1. In SmartView main window click Extras - Sequence dialog...
The sequence editor opens.

AVT SmartView for FirePackage V2.3.1
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2. Click Get current settings.

The currently valid camera settings are gathered and put:
- into the row, in which the mouse cursor is currently positioned or
- after the last row (if no row element is selected)

3. Click 7x Get current settings.

You now have a list of 8 identical rows, named Step 1...8 (first column).
All parameters that are part of sequence steps are listed in the header

row of the table (Step, RepCnt, StepMode, ..., Output4). Scroll to the

right to see all parameters.

4. Go to Shutter column, click the second entry and type 900, click the
third entry and type 800 ... click the 8th entry and type 300.

You have now set up a sequence going from shutter value 1000 ... 300
in steps of 100.

Changing parameters that are part of sequence steps do not change the
settings inside the camera immediately, but in case of clicking Apply
Sequence button.

Note With SmartView do not try out steps altering parameters con-
cerning the transfer via 1394.

@ Use only steps that do not alter the image format or band-
width.

5. Click Apply Sequence to start the sequence.

The whole list of settings is sent to the camera and the sequence mode
is started. sgg | is displayed in the status bar of the viewer window.

6. If you want to disable the current sequence click Disable Sequence. If
you want to enable the sequence again click Apply Sequence.

7. Only Pike: To determine the behavior of the sequence mode with exter-
nal control additionally to triggering: Go to I/0 tab and change the
Mode of Input 1 or 2 to SeqStep or SeqReset. For more information see
Pike Technical Manual, Chapter Which new sequence mode features
are available?

AVT SmartView for FirePackage V2.3.1
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Secure image signature (SIS) (Marlin, Pike,

Stingray)

Definition

Secure image signature (SIS) is the synonym for data, which is inserted
into an image to improve or check image integrity.

Additional information

For additional information on the secure image signature (SIS) feature read
the following chapters:

¢ Marlin Technical Manual, Chapter Secure image signature (SIS)

¢ Pike Technical Manual, Chapter Secure image signature (SIS)

e Stingray Technical Manual, Chapter Secure image signature (SIS)

Conditions

® Marlin camera (cycle time, trigger count, frame count)
® Pike camera (additional SIS features compared to Marlin)
e Stingray camera (additional SIS features compared to Marlin)

AVT SmartView for FirePackage V2.3.1
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Where to find
SmartView: Edit settings > Adv2 tab (Image stamp & counters [¥] Enable)

Pike F210C [C 0, N 191647362] - A¥T SmartView 1.8
Format |t 1 |l 2 | Cerl 3 | Trigito| LUT/Shdg. | adv 1 | Adv 2 [adv 3|

Serial pork (II0C-1,31)

Enable and Bilrate Char length Parity Stop bits
‘9s00bps v | |sbits v| [nore v| [istopbic v

configure SIS

(%) Serial port off {3 Transmitker on () Receiver on (") Bath on

Transrik | | Transmik

Receive | | Receive

Image stamp & counkers Colar

[#]Enable Ry | ] = | [Shu:uw SI5... ] [+] Calar correction
Local colar
User value: | o | anti-aliasing
172 |[Reset Camera reset
Frame Counter | |[ B5E ]}Display _
Trigger Cntr. | 0 |[Reset] [SDFI: reset] [II‘IItIahZE]

IJser sets (Memory channels)

Save [ Load ] [Set as default ] Set Ma,
[#] Don't aute hide IEI EI IEI

Figure 36: Format tab: Packed 12-bit Mode (Pike F-210C: RAW12)

Description

To activate secure image signature (SIS) perform the following steps:
1. In SmartView window click Adv2 tab.

2. InImage stamp & counters section activate [v] Enable check box.

3. Fordisplaying frame/trigger counter numbers activate Display [+] check
box.

For more information see Secure image signature (SIS) & counters on page
54,

AVT SmartView for FirePackage V2.3.1
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Smear reduction (only Pike)

Definition

Implementation

Reduce
smear

Smear is an undesirable CCD sensor artefact creating a vertical bright line
that extends above and below a bright spot in an image.

Smear reduction is a new feature of Pike cameras: it is a function imple-
mented in hardware in the camera itself to compensate for smear.

Additional information

For additional information on the smear reduction feature read the follow-
ing chapter:
e Pike Technical Manual, Chapter Smear reduction

Conditions
® Pike camera: Use only if smear appears in your images.

Where to find
SmartView: Edit settings > Adv3 tab (Smear reduction Enable)

Pike F210C [C 0, N 191647362] - A¥YT SmartYiew 1.8
Format | Ced 1 | Ceel 2 || Cerl 3 | TrigfTo | LUT/shdg, | Adv 1 | adv 2 | Adv 3

Calor correction
Carrection matrix

1025 71 ] sum is 1000
-229 1571 -142 sum is 1000
57 -411 1354 sum is 1000

Smear reduckion
Enable

[¥]oon't auto hide IEI IEI IEI I:I

Figure 37: Format tab: Packed 12-bit Mode (Pike F-210C: RAW12)

Description

Use this function only if smear appears in your images. To activate smear
reduction, perform the following steps:

1. In SmartView (Edit settings) window click Adv3 tab.

2. In Smear reduction section activate Enable check box.

AVT SmartView for FirePackage V2.3.1
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